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Copyrights 

 

Copyright © 1998 Inscriber Technology Corporation. All rights reserved.
Inscriber Technology Corporation 
180 King Street South, 3rd Floor 
Waterloo, Ontario, Canada
N2J 1P8

No part of this document may be reproduced or transmitted in any form or by any means, 
electronic or mechanical, for any purpose, without the express written permission of 
Inscriber Technology Corporation. 

Inscriber is a registered trademark of Inscriber Technology Corporation. TitleMotion and the 
Inscriber logo are trademarks of Inscriber Technology Corporation.

This document describes Inscriber TitleMotion version 3.5. Subsequent revisions of the 
product may provide additional functionality or modify the limits described in this 
document. 

The information in this manual is furnished for informational use only, is subject to change 
without notice, and should not be construed as a commitment by Inscriber Technology 
Corporation. 

Software License Agreement 

1. NOTICE. Inscriber Technology Corporation IS WILLING TO LICENSE THE ENCLOSED 
SOFTWARE TO YOU ONLY ON THE CONDITION THAT YOU ACCEPT ALL OF THE TERMS 
CONTAINED IN THIS LICENSE AGREEMENT. PLEASE READ THIS LICENSE AGREEMENT 
CAREFULLY BEFORE OPENING THE SEALED DISK PACKAGE. BY OPENING THIS 
PACKAGE YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO 
NOT AGREE TO THESE TERMS WE ARE UNWILLING TO LICENSE THE SOFTWARE TO 
YOU, AND YOU SHOULD NOT OPEN THE DISK PACKAGE. IN SUCH CASE, PROMPTLY 
RETURN THE UNOPENED DISK PACKAGE AND ALL OTHER MATERIAL IN THIS 
PACKAGE ALONG WITH PROOF OF PAYMENT, TO THE AUTHORIZED DEALER FROM 
WHOM YOU OBTAINED IT FOR A FULL REFUND OF THE PRICE YOU PAID. 

2. Ownership and License. This is a license agreement and NOT an agreement for sale. We 
continue to own the copy of the software contained in this package and any other copy that 
you are authorized by this Agreement to make (the Software”). Your rights to use the Software 
are specified in this Agreement, and we retain all rights not expressly granted to you in this 
Agreement. Nothing in this Agreement constitutes a waiver of our rights under any copyright 
law or any other law. 
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3. Permitted Uses. 

3.01 Right to Install and Use. You may install and use the Software on the hard disk drive of 
any single compatible computer that you own. However, you may not under any 
circumstances have the Software installed onto the hard drives of more than one computer at 
the same time, nor may you install the Software onto the hard disk drive of one computer and 
then use the original distribution media on another computer. If you wish to use the Software 
on more than one computer, you must either erase the Software from the first hard drive 
before you install it onto a second hard drive, or else license an additional copy of the 
Software for each additional computer on which you want to use it. 

3.02 Right to Copy. You may make one (1) copy of the Software for backup and archival 
purposes, provided that the original and the copy are kept in your possession, and that your 
installation and use of the Software does not exceed that allowed in Section 3.01, and 
provided you reproduce our copyright notice on the copy. 

3.03 Right to Transfer. You shall not assign, transfer sublicense, rent, lend, or lease the 
Software or your rights under this Agreement without our prior written approval. 

4. Prohibited Uses. You may not, without written permission from us: (a) use, copy, modify, 
merge, or transfer copies of the Software or documentation except as provided in this 
Agreement; (b) use any backup or archival copy of the Software (or allow someone else to use 
such copy) for any purpose other than to replace the original copy in the event it is destroyed 
or becomes defective; or (c) disassemble, decompile or unlock, reverse translate, or in any 
manner decode the Software or the dongle security device for any reason. 

5. Limited Warranty. We make the following limited warranties from the date you acquired 
the Software from us or our authorized dealer:

Media. For a period of twenty (20) days, the distribution media and documentation in this 
package will be free from defects in materials and workmanship under normal use. If the 
distribution media or documentation fail to conform to this warranty, you may, as your sole 
and exclusive remedy, obtain a replacement free of charge if you return the defective disk or 
documentation to us with a dated proof of purchase.

Interlock Security Device. Provided you are in compliance with this Agreement, we will 
replace a damaged or defective interlock security device (dongle) no matter what the cause of 
the damage. In order to receive a replacement device, you must return the damaged device to 
Inscriber Technology Corporation, 180 King Street South, 3rd Floor, Waterloo, Ontario, 
Canada N2J 1P8. 
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(c) WARRANTY DISCLAIMER. EXCEPT AS PROVIDED ABOVE, THE SOFTWARE AND 
DOCUMENTATION ARE PROVIDED ON AN AS IS BASIS, AND WE DO NOT WARRANT 
THAT THE SOFTWARE WILL MEET YOUR REQUIREMENTS OR THAT ITS OPERATION 
WILL BE UNINTERRUPTED OR ERROR-FREE. WE EXCLUDE AND EXPRESSLY DISCLAIM 
ALL EXPRESS AND IMPLIED WARRANTIES AND CONDITIONS NOT STATED HEREIN, 
INCLUDING THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE. 

Some jurisdictions do not allow the exclusion of implied warranties, so the above exclusion 
may not apply to you. This limited warranty gives you specific legal rights, and you may also 
have other legal rights, which vary from jurisdiction to jurisdiction. 

6. LIMITATION OF LIABILITY. IN NO EVENT SHALL WE BE LIABLE FOR ANY INDIRECT, 
INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES, INCLUDING BUT NOT LIMITED 
TO LOSS OF PROFITS, REVENUE, DATA, OR DATA USE, OR MACHINE USE, INCURRED BY 
YOU OR ANY THIRD PARTY, WHETHER IN AN ACTION IN CONTRACT OR TORT, EVEN IF 
WE HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. OUR LIABILITY TO 
YOU FOR ANY LOSSES SHALL NOT EXCEED THE GREATER OF $500 AND THE AMOUNT 
YOU ORIGINALLY PAID FOR THE SOFTWARE. 

Some jurisdictions do not allow these limitations or exclusions, so they may not apply to you. 
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United States Government Restricted Rights. The enclosed Software and documentation are 
provided with Restricted Rights. Use, duplication or disclosure by the U.S. Government or any 
agency or instrumentality thereof is subject to restrictions as set forth in subdivision 
(c)(1)(ii) of the Rights in Technical Data and Computer Software clause at 48 C. F.R. 252.227-
7013, or in subdivision (c)(1) and (2) of the Commercial Computer Software -- Restricted 
Rights Clause at 48 C.F.R. 52.227-19, as applicable. Contractor Manufacturer is Inscriber 
Technology Corporation, 180 King Street South, 3rd Floor, Waterloo, Ontario, Canada N2J 
1P8.

8. Termination. This license and your right to use this Software automatically terminate if you 
fail to comply with any provisions of this Agreement, destroy the copies of the Software in 
your possession, or voluntarily return the Software to us. Upon termination you will destroy 
all copies of the Software and documentation. Otherwise, the restrictions on your rights to 
use the Software will expire upon expiration of the copyright to the Software. 

9. Miscellaneous Provisions. This Agreement will be governed by and construed in 
accordance with the laws of the Province of Ontario and not by the 1980 United Nations 
Convention on Contracts for the International Sale of Goods, as amended. This is the entire 
agreement between us relating to the contents of this package, and supersedes any prior 
purchase order, communications, advertising or representations concerning the contents of 
this package. No change or modification of this Agreement will be valid unless it is in writing, 
and is signed by us. 
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10.Quebec Transactions. If you reside in the Province of Quebec, Canada, you agree to the 
following: The parties hereto have expressly required that the present Agreement and its 
Exhibits be drawn up in the English language. Les parties aux presentes ont expressement 
exige que la presente convention et ses Annexes soient redigees en langue anglaise. 

If you have any questions about this Agreement, write to us at Inscriber Technology 
Corporation, 180 King Street South, 3rd Floor, Waterloo, Ontario, Canada N2J 1P8, or call us 
at 519-570-9111. 

PRINTED IN CANADA
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Introduction

 

What is Inscriber TitleMotion?

 

TitleMotion is a full-featured character generator for professional users who need to create 
stills, rolls, and crawls for their NLE systems and to animate those displays in virtual 3D 
space.

As a character generator, TitleMotion offers extensive typographic and color controls for 
design flexibility. Text characters are always fully anti-aliased and broadcast quality. Text 
characters can be sized, compressed, expanded, slanted, converted to small caps, or rotated 
with only a few clicks of the mouse. Direct access to TrueType fonts provide a virtually 
unlimited variety of typefaces to suit the needs of each layout. 

To complement the typographic controls, TitleMotion offers a variety of edging and shadow 
options, including drop, extruded, offset, and soft shadows. Choose from a palette of 16.7 
million colors and up to 256 levels of transparency.

Anti-aliased graphic objects serve as text backdrops. Graphic objects have attributes similar 
to text—foreground, beveled edges, and shadows—that can be colored and blended just like 
text characters. Anti-aliased logos, complete with key channel, can be placed on graphic 
objects and sized and positioned anywhere on screen.

TitleMotion enhances the CG functionality with animation creation and playback, taking the 
two dimensional (2D) text and graphic objects you create in the CG Editor and animating 
them in virtual three dimensional (3D) space. The special click-and-drag functionality of the 
program lets you adjust almost every aspect of your animation using only the mouse. You can 
position, rotate, scale, or change the shape of your text and graphic objects just by selecting a 
tool and using the mouse to make the change.

 

Interacting with your NLE System

 

TitleMotion is designed to work with a variety of NLE systems. A printed addendum included 
in your TitleMotion package explains how to use TitleMotion with your NLE system.

If your NLE system came with Inscriber/CG as the title tool, TitleMotion replaces that title 
tool with enhanced CG features and the animation module.
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Getting Started

 

This Getting Started guide is divided into three sections: 

• Basics, quickly summarize the essential program features

• Tutorials, lead you through the process of creating your first CG title and animation

• How To, provides step-by-step guides to the most common tasks in TitleMotion

If you need help identifying a menu or dialog option, try the context-sensitive help. Click on 
an option and press F1. For detailed help, try the Help Topics option on the help menu to use 
the full program reference and the keyword searching.

 

Documentation Conventions

 

All the TitleMotion documentation uses the same standard typographic conventions.

• Menu items, button names, and options in dialog boxes are capitalized; for example, the 
Size & Attributes tab, the Take button, and the Tools menu.

• Menu items are identified with a full path name. File

 

➝

 

Open is the Open option on the File 
menu; Element

 

➝

 

Constrain

 

➝

 

Word Wrap is the Word Wrap option on the Constrain 
cascading menu called from the Element menu.

• Key names are shown in small capitals: 

 

SPACE

 

, 

 

CTRL

 

, 

 

ENTER

 

. Keys to be pressed in 
combination have a plus sign between them; for example 

 

CTRL

 

+

 

TAB

 

 and 

 

CTRL

 

+

 

N

 

.

• The 

 

PLUS

 

 and 

 

MINUS

 

 keys on the numeric keypad are different from the 

 

PLUS

 

 and 

 

MINUS

 

 keys 
on the main keyboard.

 

Printing Help Topics

 

When you look at the help file outline on the Contents tab of the help browser, think of each 
topic as a book. You can print a single page from the book or the entire book at once.

• To print a page from the help browser, click on Contents, select the page you want to print, 
and click on the Print button.

• To print an entire book from the help browser, click on the book you want to print and then 
click on the Print button.
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TitleMotion Basics

 

There are three elements needed to define a layout: background, text, and graphic objects.

• The default background is usually a source clip from your NLE system. You can block the 
clip with color or imported bitmap images.

• Click between the square brackets in the CG Editor window and start typing to add text to a 
layout. The CG Palette offers color and style groups for quick formatting, or you can use the 
options on the Size & Attributes tab for custom text formatting.

• Click on a shape icon on the CG Palette to create graphic objects. In the CG Editor window, 
click and drag the mouse to set the graphic size. Choose a color or style group for the object 
and then use the mouse to drag the object into position. Change the size by clicking on any 
corner and dragging it to a new position.

• To animate the objects in the layout, switch to the FX Editor window and define the path 
and timeline for each object in the layout.

• Once you have finished your layouts, choose File›Save to return to your NLE system. 
TitleMotion is tightly integrated with most NLE systems, so the images you create will 
appear automatically in your graphics library or timeline; you will have to import the 
images for use with other systems. Check the NLE Integration Addendum for details.

The rest of the Basics section is divided into several topics:

• TitleMotion Interface • Texture Basics

• Type Format Basics • Keyframe Basics

• Font Basics • Spline Basics

• Style and Color Group Basics • Display Basics

• Graphic Object Format Basics • Filter Basics

• Background Basics • Motion Template Basics

• Layout Template Basics • Timing Basics
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TitleMotion Interface

 

TitleMotion is composed of the CG and the FX Editor that work together to create stills, rolls, 
crawls, and animations . The CG Editor allows you to design, format, and edit both text and 
graphics. The FX Editor animates the layouts that you create in the CG work area. 

The graphic below identifies the various items in TitleMotion. 

CG Toolbar

CG Palette

Scrapbook
CG Work Area

Tabbed Pages

Tabbed Pages

FX Work Area

FX Toolbar

Animation
     Palette
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Type Format Basics

 

To create text, click on the Text button on the CG Palette. The text line is marked with square 
brackets. Click inside those brackets and start typing. You can use the predefined color and 
style groups on the CG Palette for quick formatting, or you can use the options on the various 
tabs for custom text formatting.

If you choose custom formatting, you have many options:

• Choose a typeface from the Fonts list.

• Set the text, height, and width.

• Set the shadow size, type, and direction.

• Set the edge, size, and type.

• Choose the other special formatting options you want (custom kerning, leading, small 
caps, and so on).

Formatting changes are instantly applied, so you see the effect of your changes immediately.
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Font Basics

 

You can use any TrueType font installed for 
Windows. 

• When you look at a font list, all fonts from the 
same family are grouped together.

• To see the fonts in their typeface, click on the 
Browse button on the Size & Attributes tab.

• All fonts are scalable from 10 to 999 scan lines and are automatically anti-aliased to reduce 
jagged curves.

• If you open a layout with a missing font, TitleMotion will substitute the missing font with 
the first font in the list.

• The TitleMotion compact disc includes many TrueType fonts to get you started.
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Style and Color Group Basics

 

Every text line or draw object belongs to a style or a color group. They take on all the 
properties of that style or color definition.

 

Text

 

• Style definitions save all the formatting options (height, 
width, shadow size, edge type, and so on) set on the Size 
& Attributes tab and all the color and texture options set 
on the Color & Texture tab.

• Color definitions save only the color and texture options 
set on the Color & Texture tab.

• If you click on a line assigned to a style group and 
change a format or color option, all the lines in the 
layout that share the same style group are also updated.

• If you click on a line assigned to a color group and 
change a color or texture option, all the lines in the 
layout that share the same color group are also updated.

• If you just want to change the format for a few letters or words, but not all the lines in the 
style or color group, select the letters you want to change first and TitleMotion will treat the 
changes as local formatting.

• You can change the way style groups work with the Freeform Style option.

 

Graphics

 

All the items described for text apply to graphic object style and color groups EXCEPT that 
graphic object styles do not include width and height. Width and height are defined 
separately for each graphic object.

Style Groups

Color Groups
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Graphic Object Format Basics

 

To create a graphic object, click on a graphic button on 
the CG palette. You can use the predefined color and style 
groups for quick draw object formatting, or you can use 
the options on the various tabs for custom graphic 
objects formatting.

If you choose custom formatting, you have many options:

• Choose a shape from the Style & Attributes tab.

• Change the object height and width. You can type in a 
new size in the Graphics Size & Attributes tab or you 
can just click on a corner of the object and drag it to a new position.

• Click on a bevel type on the Graphics Size & Attributes tab and set the size of the bevel with 
Edge (rectangular shapes only).

• Try an outlined object by clicking on Outline. The Edge size sets the size of the outline.

• Polygons and splines are defined with control points. Click on any control point and press 

 

SPACE

 

 to add a new control point. Then drag that point into place. To delete a control point, 
click on it and press 

 

DELETE

 

.

• Logo objects display a bitmap image instead of the graphic shape. If you use 32-bit images 
with alpha as logos, you can display non-rectangular logos.

Style Groups

Color Groups

Graphic Objects

Control Point

Control Point

Control PointControl Point
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Background Basics

 

By default, layout backgrounds are transparent. When you render a layout, you see the text 
and draw objects on top of the source clip. You can replace the background with a solid or 
blended color or you can import a still image to block the clip.

• On most NLE systems, the background is filled with a frame from the source clip. 

• If a source clip is not available the background is filled with a pattern. This pattern is not 
included in your final rendered images. You can change the fill pattern in the Preferences 
dialog.

• Use the color selection options to set a color background. Make sure the video Top and 
Bottom transparency values are set to 0% to block the clip. Add a pattern to the color if you 
want.

• Use the options on the Background tab to change the angle and area of color blends.

• Click on the Image box to load a background image.
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Layout Template Basics

 

Templates allow you to define standard layouts for projects. 

• When you need a new title, choose the base template, change the text, and save the layout. 
Templates can store all the elements of a layout.

• TitleMotion comes with a set of predefined templates. You can add your own templates to 
the list.

• To add a template to the list, define the elements of the template and choose 
File

 

➝

 

Registry

 

➝

 

CG Layouts. Click on Add and give your template a name.

• Templates include transition type information: crawl, roll, animation, or still. 

• Animation templates do not save path information. Use the Motion Templates list in the FX 
Editor window to save animation paths.
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Texture Basics

 

Textures are bitmap images applied to text and draw objects to supply visual interest and 
contrast to the objects.

• You can use an image in any supported bitmap form as a texture.

• You can apply different textures to the foreground, shadow, and edge of text or draw 
objects.

• TitleMotion keeps track of all the textures you use in a layout in a list. This list is saved as 
part of your template or layout.

• Click on the Texture Image box on the Color & Texture tab to call up the list of textures. 
Double-click on a blank space in the list, and choose one or more images from the Open 
Image box. You will see a picture of each image in the list. Select a texture from the list and 
click on OK to use the texture.

• You can tint a texture image with color by selecting the Tint checkbox.

• The Tile and Size options in the Color & Texture tab determine whether you see only part of 
the image on each text character or draw object, or if the image is squeezed so that it fits on 
each object.

• Compositing uses the red, green, blue, or alpha levels in the texture image to make part of 
the image transparent.
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Keyframe Basics

 

Keyframes set the path for each object in your animation. They mark a point of change in the 
path the animation is following. This transition point can be a change in the object size, 
direction of motion, spin, transparency, or any other animation property.

• The first keyframe in any path is marked as keyframe 1. The rest of the keyframes in the 
path are numbered sequentially.

• Each object has its own path and its own set of keyframes.

• The markers on the path outline identify the position of each frame between the keyframes.

• To add a new keyframe, choose Edit

 

➝

 

Insert Keyframe and select Before Selected 
Keyframe or After Selected Keyframe from the menu. If the selection cursor is sitting 
between two keyframes, you can also select At current Frame to insert a new keyframe at 
that point.

• The selected keyframe is outlined in yellow. You can select a keyframe by 
clicking on it, or by selecting the path and the Key # on the tabbed pages. If 
you have overlapping paths, click on the number marker for the keyframe 
you want.

• Use controls on the Placement, Shape, and Filter tabs to change the 
properties for the selected keyframe. 

• By default, each object in the layout is has its own path in the 
animation. You can change this with the Animation Settings dialog 
called from the Settings button  on the CG Editor toolbar.

Keyframe

Keyframe

Frames



 

TitleMotion 25 

 

Spline Basics

 

A spline is a curve that is defined by the sum of the points between two keyframes. Drag the 
keyframes to the position you want and TitleMotion automatically defines the spline curve so 
that the object moves smoothly along the path.

• There are really three spline curves for each path: the Position, Rotation, 
and Shape splines. Make sure you select the spline you want to adjust 
before changing the properties. 

• You can only see changes in the Rotation spline when you change the 
orientation or set a spin on the path. You can only see change in the 
Shape spline when you change a property on the Shape tab.

• Each spline has three properties. The Tension property adjusts the rigidity of the spline to 
tighten or loosen the curve.

• The Continuity property affects the smoothness of the curve. You can make a sharp corner 
effect or an exaggerated swoop effect by changing the Continuity valve.

Spline Sliders

Tension = 0Tension = -5 Tension = -1 Tension = +1 Tension = +5

Continuity = 0Continuity = -5 Continuity = -1 Continuity = +1 Continuity = +5
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• The Bias property weights the changes in the keyframe toward the segment coming into the 
keyframe or toward the segment coming out of the keyframe.

• Use the Ease In and Ease Out controls with the other spline properties to increase or 
decrease the speed into or out of the selected keyframe.

Bias = 0Bias = -5 Bias = -1 Bias = +1 Bias = +5
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Animation Preview Basics

 

When you are working with animations, the Preview window gives you an idea of what the 
final animation will look like. You cannot see the final animation, composited over a 
background clip, until you return to your NLE system and render the animation.

• To preview an animation, click on the green Go button on the Preview toolbar. Other 
controls on the toolbar allow you to play the animation from the current keyframe, or even 
in reverse.

• You can change the way the preview display looks by changing the display options on the 
Animation Palette.

• By default, you see the paths for all the objects in the animation in the work area. If this 
makes the display too complicated, turn off Display All Paths so that only the selected path 
is visible. To select a new object in this view, choose one from the Object drop-down list on 
the tabbed dialog.

• The Snapshot of Selected Objects and Snapshot of All Objects display options, switch 
between wireframe preview and showing you a rendered bitmap of the objects in the path.

• If you select Display Text Outlines, the keyframes that are not selected show a wireframe 
outline of the object.

Go Button

Display All Paths Snapshot of 
  Selected Objects

Snapshot of All ObjectsDisplay Text Outlines
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• The Go Options on the Go menu provide an additional set of display controls.

Choose Selected Object Only to show a preview of the current path only. Choose Show Trails 
to leave a wireframe trail in the Preview window when you run the animation. This helps to 
see how smooth the path is. Choose Clip to Screen to trim the display of anything outside 
the visible screen area.
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Filter Basics

 

Filters are special effects that modify the appearance of the objects in the animation for 
special effects. For example, increase the luminance of an object to create a moving glow 
effect. Use the transparency control to make an object fade in over time. All of the filter 
options are located on the Filter tab.

• Make sure you select the keyframe you want to modify before setting any filter.

• When you insert a new keyframe, it duplicates the Filter effects of the selected keyframe.

• Because of the nature of the filters, you cannot see the effect of the filters in the Preview 
window play back. You must return to your NLE system and render the animation to see 
the effect of these filters.

• Double-click on the icon of any filter property to reset all the default values for that 
property. Double-click in any numeric field to reset the default values of that numeric field.

• To apply the same filter to more than one keyframe, 
set the values you want in the appropriate fields and 
then right-click on the icon of the filter property. 
Choose the option you want to apply to the keyframes: 
Apply to all Keyframes, Apply to all Forward, or Apply 
to all Previous.

• Use the Stagger property of templates to create travelling filter effects. For example, to 
make each letter of a word glow in sequence, create a template that makes an object glow 
and saves it in the template registry. Apply it to all the letters in a word with a stagger of 5 or 
10 frames. When you play back the animation, each letter will glow in turn.
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Motion Template Basics

 

Motion templates store animation effects so that you can reuse them without having to define 
the full effect each time. While TitleMotion ships with a set of templates, the real usefulness 
comes when you start saving your own templates.

• Templates can save information for a single animation path or many animation paths. 
When you apply a template, you can apply the information to a single object or to multiple 
objects. Use the Count and Apply to All Objects options on the tab to apply a template to 
more than one object.

• If you apply a path to more than one object, use the Stagger field to delay the start of each 
subsequent path by a certain number of frames.

• Overwrite replaces the current path with the template path. If this option 
is not selected, the template is added to the existing path.

• Relative and Absolute determine whether any position information is 
saved from the current keyframe. To use all the position information 
from the template choose Absolute.

• Before and After determines whether the template is added to the front or 
end of the current path.
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Timing Basics

 

The Time tab includes all the controls for timing the objects in your animation. With most 
NLE systems, TitleMotion shows you the length of the source clip on the timeline. With some 
systems, or in certain cases, no source clip is available.

• All times in TitleMotion are relative time, measured from the start of the source clip. They 
are not absolute times from your NLE system.

• Each object in the animation has its own path on the timeline. You can change the timing 
for any object without affecting the rest of the objects in the timeline.

• To make a path longer, stretch the slider on the timeline; to make a path shorter, shrink the 
slider on the timeline. 

• By default, moving objects remain on display until the end of the animation, even if the 
object has a shorter pothook remove an object from display at the end of the path, unpin it 
by selecting the Remain on Screen button.

• To stretch or shrink all the paths proportionally, change the total duration of the animation 
in the All Paths field.

Start Frame Field
End Frame Field
Duration

All Paths
Final Frame

Render Path
Allow Modifications

Remain on Screen
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Tutorial 1: Creating a Lower Third

 

This tutorial is designed to help you master many of the key controls and concepts in 
TitleMotion. You should work through the entire tutorial while you have the program 
running, and complete each step as you read. You will learn how to choose a template, change 
style attributes, apply local formatting, center text, create a new graphic object, and use a 
gradient blend. Each of these basic steps will familiarize you with the interface and provide 
you with the skills to create complex layouts on your own.

 

Step 1: Choosing a Template

 

TitleMotion ships with a list of templates ready for you to use. A template saves all the 
formatting information contained in a layout including styles, graphic objects, colors, and 
background. Until you become a more advanced user, it is probably a good idea to begin with 
a template, then modify the template to suit your purposes. Once you are more familiar with 
the program, you can create and save your own custom templates. For this tutorial, use the 
entry named Lower Thirds 1.

Layout Template List Layout Type List Text Button

Graphic Objects

Color Groups

Style Groups

Scrapbook

CG Work Area

Tabbed Pages

Status Bar
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1  If TitleMotion is not already running, launch the program. You 
may see a clip of your source video in the CG Editor window, or it may 
be filled with a checkerboard pattern or it may be black with tiny blue 
dots.

2 All of the layout templates are listed in the Layout Template list 
which you can find on the CG toolbar. (The list may look different 
from the one in the picture on the left.)

3 Click on the down arrow to view the 
templates in the drop-down list, and 
select Lower Thirds 1. TitleMotion loads 
the template, and the CG Editor window 
now contains the information saved 
specifically in the Lower Thirds 1 
template. You should see two text lines 
separated by a red line.

4 This is the template that you will work 
with throughout the remainder of this 
tutorial. You may want to select other 
templates from the list to check the other 
layouts that are available for your use. 

 

Step 2: Changing Style Attributes

 

A style is a group of preset attributes that you can apply to 
any text line. In TitleMotion, a style consists of all 
formatting elements including color, font, size, shadow, 
edge, kerning, and leading. All of these controls are 
located on the Size & Attributes tab for text. 

The CG Palette contains eight preset style chips (labeled 9 
to 16) and eight preset color groups (labeled 1 to 8), but 
you can change them to suit your needs for each job. By 
default, when you make a change to a style or color group, 
all the lines that share that same group also change. Styles 
can save you lots of time because you only have to define 
the attributes once, then just apply the style to any text 
line. In this example, work with Style 10.

1 Click at the end of the text line “Name”, then press the backspace key to delete the letters.

2 Type “Barbara Walker” or any other name you want. 

Style Groups

Color Groups
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3 On the Size & Attributes tab, choose a new font from the font drop-down list. The example 
screens use Times New Roman but you can select any font in your list. Notice that the text 
line “Location” also changed because it shares the same style group.

4 Type a size value of 45 into the Height field to change the size of the text. You can also click 
on the bounding bracket of the text line, then drag up , down, left, or right until your text 
is the correct size and rotation. The following graphic explains where to grab the bracket if 
you want to adjust the height, width, and rotation.

5 Type a value of 2 into the Shadow field, and choose 
Soft from the list of shadow types. Type a value of 3 
into the Soft shadow field. Choose any other shadow 
direction than the one that is currently selected. 
Note that you do not need to press 

 

ENTER

 

 after you 
type in a value; TitleMotion automatically updates 
the display. Watch as the text line changes to display 
the new values you set.

6 Type a value of 1 into the Edging field, and choose Outline from the Edge types.

7 Switch to the Color & Texture tab by clicking on the tab header. When you switch tabs, the 
controls in the Size & Attributes tab are hidden and the controls on the Color & Texture tab 
become active.

8 Click on the Foreground Chip and then click on the Color Blend Chip 
until it says TOP. Selecting a different color for the top and bottom 
values will create a color blend of the two colors. Use the Square Color 
Selector or the slider to choose a new color for the top half of the text 
line. Click on the Color Blend Chip again until it says Bottom. Select a 
different color for the bottom half of the text line. If you are having 
trouble choosing colors, type this combination into the HLS 
component fields: Top–H: 233, L:48, S:84; Bottom–H:233, L:81, S:92.

9 Click on the Edge Chip, then click on the Color Blend Chip until it says 
SOLID. Choose a new color for the Edge. Try H: 235, L:54, S:94.

Grab here to adjust both the height and width.

Grab here to adjust the width only.

Grab here to rotate the text line.
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10 Click on the Shadow Chip, then 
click on the Color Blend Chip 
until it says TOP. Choose a color 
for the top of the shadow. Click 
on the Color Blend Chip until it 
says Bottom, then pick another 
color to blend with the top half. 
Try H:73, L:83, S:62 for the 
Bottom and H:73, L:73, S:0 for 
the Top.

11 Select the text line “Location”. 
Delete the line and type in 
“Washington”, or any other city 
name. This text line looks 
exactly like the line “Barbara Walker” because it shares the same style group. At this point 
in the tutorial, the Lower Third should look like the sample above.

 

Step 3: Applying Local Formatting

 

In Step 2 you changed the format of text lines that belong to the same style group. If you 
changed the attributes of one line, the other line would change also. However, there may be 
times when you want to change the attributes of only part of a sentence, such as a word or 
phrase, and have the rest of the lines comply with the style. If you 

 

select

 

 a text line or a word 
first, then make a change, the rest of the line that share the style will not change. 

1 Double-click on the text line “Washington” to select it. 
Selected text is enclosed by a box as in the graphic to the 
right. 

2 Switch to the Size & Attributes tab and type a value of 
80% into the small caps field to convert the line “Washington” to small caps. Remember to 
select the line before making the change, so the change is local and the line “Barbara 
Walker” will not change. 

3 Notice that the Format Sample on the CG palette now contains a 
small + sign beside the style number. This symbol appeared 
right after you made your first change to the text, indicating that 
the current text deviated from the style attributes contained in 
group 10. TitleMotion considers this local formatting because it 
only applies to the selected text. 
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Step 4: Centering Text

 

Now that the text is formatted, try centering it on the screen. 

1 Under the Element

 

➝

 

Align All menu, choose Center Tab. 
Both of your text lines will shift to the center tab.

 

 

 

2 If you wanted to center one line, but not the other, just 
click at the beginning of the line you want to center, then 
press 

 

TAB

 

 twice. Center the “Barbara Walker” line of text 
with tabs.

 

Step 5: Working with NTC Text

 

NTC stands for Non-Tab Constrained text, or free floating text. You can center text using tab 
stops, but you may also want to convert a text line to NTC to move it freely anywhere in the 
layout.

1 To create a new line of text, click at the end of the text line “Washington” and press 

 

ENTER

 

. 
Empty brackets will appear under the line “Washington”. Type in the words “Reporting 
Live...”.

2 To convert the line to NTC, press 

 

CTRL

 

+

 

TAB

 

. To move the line, hold down 

 

CTRL

 

 and the left 
mouse button, then drag it to the top right corner of the layout.

3 Formatting NTC text is just like formatting any other text line. Follow Step 2: Changing 
Style Attributes to choose new attributes for the text line “Reporting Live...”. Set the height 
to 45 and apply 1 pixel of white Outline edging on the Size & Attributes tab.

4 When you moved the text line to the top right corner, it may have moved outside the Video 
Safe Title Area. To view the Safe Title bounding box, click on the View tab, then select the 
Video Safe Title Area checkbox. This marker is for your use in creating the layout only; it 
will not appear when you save the layout, or when you output it to video. If the text line is 
outside the Safe Title Area, hold down 

 

CTRL

 

 and drag it until it is within the boundary.

 

Step 6: Formatting Graphic Objects
So far, you have only worked with text lines. You may have tried to select the red line 
separating the line “Barbara Walker” from the word “Washington” with no success. That is 
because you cannot select a graphic object until you switch to draw mode. TitleMotion has a 
text mode and a draw mode to make it easier to work when there are lots of objects on the 
screen, especially overlapping objects. 

1 Click on the Draw button on the CG toolbar 
to switch to draw mode. The controls on 
the Size & Attributes are different in draw 
mode. All text functions are removed and 
replaced with graphic object controls.

Text Draw
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2 Change the size of the shadow and the amount of edging on the rectangle. On the Size & 
Attributes tab, type a value of 3 into both the Edging field and the Shadow field.

3 Select Drop for the Shadow type, and Flat for the Edging type.

4 From the Graphic Object list, choose Horizontal Panel.

5 To change the size of the object, type a value of 10 into the 
Vertical field, and a value of 550 into the Horizontal field. 
You can also click on one of the control points and drag 
the object until it is the correct size. Typing values into 
the fields is a little more precise, but there may be times 
when you need to tweak the size by dragging.

6 On the CG palette, click on Color group 2.

7 Switch to the Color & Texture tab and click on the Edge Chip. Change the color to H:2, 
L:43, S:56. Leave the shadow color the same.

8 To move the object into a better position, click on it and then drag the object so that it is 
centered underneath “Barbara Walker”.

Step 7: Creating a New Graphic Object
Now that you have changed the attributes of the graphic object, create a new rectangle to 
place underneath “Reporting Live”.

1  Click on rectangle chip on the CG palette, then click anywhere 
on the CG Editor window and drag until the object is big enough 
to fit “Reporting Live...” on top. You can create duplicate objects by 
clicking on the existing horizontal panel and pressing ENTER. 

2 On the CG Palette, click on Style 9. If you want, you can apply 
your own attributes to the rectangle. Just follow the same basic instructions that you 
completed in Step 3: Changing Style Attributes to apply a shadow and edge, and to change 
the colors. Remember that graphic objects belong to style groups the same way text lines 
do.

3 Drag the object to move it just inside the Safe Title Area.

4 Click on the Text button on the CG toolbar to switch to text mode. 
Hold down CTRL and drag the line “Reporting Live...” until it is 
centered on the rectangle.
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Step 8: Defining Backgrounds
The only major item you have left to define is the background. A background can be a color, 
an image, or source clip from your NLE. These instructions explain how to define all three 
types of backgrounds. Be sure to follow the instructions all the way through so you get a good 
idea of how to apply each type of background.

If your NLE system has supplied a video clip background, setting a color, pattern, or image 
background in TitleMotion blocks the video clip from view.

1 Switch to the Background tab.

2 Make sure the Color radio button is selected. It should already be 
selected because it is the default set in the template. When this button is 
selected, you can define a color for the background.

3 Click on the Color Blend Chip until it says TOP. Choose a color for the 
top portion of the gradient blend, then click on the Color Blend Chip 
until it says BOTTOM and choose another color. Try white for the top 
portion and black for the bottom portion.

4 In the Gradient controls section on the Background tab, change the Top gradient value to 
50% and the Bottom gradient value to 15%.

5 In the Pattern Size field, type in a value of 5. Now choose any pattern listed above the 
Pattern Size field. Experiment with patterns and sizes until you find one that looks good 
with your layout. The repeating pattern will appear as a blend of the two colors you chose 
for the gradient. In this case, the repeating pattern is grey because it is a blend of white 
and black. You can take the pattern off by choosing the plain pattern from the scrolling 
list. It is the first pattern in the list.

6 Now select the Image radio button. When this button is selected, you can select an image 
for the background. 

7 Click on the Image box, then choose any bitmap image on your system to use as your 
background. 

8 To set a video background, click on Video. If a source clip is available, a sample frame fills 
the background. If no source clip is available, all transparent areas are filled with a filler 
pattern. If you want to change the filler pattern, choose File➝Preferences and select 
another pattern from the scrolling list.
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Tutorial 2: Creating an Animation

This tutorial offers step by step instructions for creating and running an animation in 
TitleMotion. As you work through the procedures, experiment with various program controls 
to see how each change affects the outcome of your animation.

Each of the following procedures are illustrated using the text line “Flying Text” and an oval 
object as examples. You can create any combination of text and objects you want, or you can 
duplicate this examples to make sure that you are producing the same results.

Tutorial 2 includes more explanation than Tutorial 1, since the concepts involved with 
animation can be difficult to understand. In most cases, the concepts will be clearer if you use 
the Preview frequently, so that you can see the effect of each tool and change.

Step 1: Access the Animation Module
1 Launch TitleMotion from your NLE system.

2 Before you switch to the FX Editor window, create the text and objects in the CG Editor 
that you want to animate. Apply styles, color and textures, and so on, as you normally 
would for any CG layout. If you want to change some formatting later, you can always 
switch back to the CG Editor and make changes. 

FX Work Area

Display Options
Spline Path

Keyframe

Preview Toolbar

Shape Controls

Position Controls
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For this example, create a text line 
and an oval graphic object similar to 
the image on the right.

3 When your text and graphic objects 
are formatted, you need to define 
your layout as an animation before 
the Animation button becomes 
available. From the Layout Type 
drop-down list on the CG toolbar, 
select Animation. (In some NLE 
systems, you must set the layout 
type before opening TitleMotion. If 
you cannot change the Layout Type 
with the drop-down list, check the addendum for using TitleMotion with your NLE for 
instructions on creating an animation.)

4 First decide how you want to deal with your text and objects in TitleMotion: as single 
objects, as lines, or on a per character basis. To open the Animation Settings dialog, click 
on the Settings button located immediately to the right of the Layout Type drop-down list. 

• If you animate the items in your layout as a Single 
Object, everything will move together as one unit. 

• If you animate the items As Lines, each line of text and 
each graphic object has its own animation path.

• If you animate the items As Characters, every 
character in every line of text has its own path. Each 
graphic object in your layout will also have a separate 
path.

Leave the Export Background checkbox unchecked. For 
some layouts, you may want to align text or objects with 
your background in the FX Editor window. In that case, 
select the Export Background checkbox.
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5 To open the FX Editor window click on the Animation button on the CG 
toolbar. The FX Editor window will appear on top of the CG Editor window.

By default, objects in the FX Editor window are displayed as rendered objects to make it 
easy to identify which object you are working on. 

Step 2: Select the Path
1 Since there are two objects in this layout, you must identify which object you want to work 

with first. For this tutorial, you will work with the Flying Text line first. To select the 
Flying Text line click on it in the FX work area. 

2 If you have a lot of paths and a lot of keyframes to choose from, use the 
drop-down list objects on the Placement tab. For this example, there are 
two items in the list: Flying Text and Oval. TitleMotion identifies your 
objects by name in this list. 

Step 3: Change the Display Options
1 TitleMotion offers several different display options to help simplify your work space. 

These options are all located on the Animation palette. By default, TitleMotion displays all 
paths in wireframe view with the current point in time rendered for each path. You can 
change and combine the display options any at time to suit your needs.

• Display All Paths shows every path in 
your animation. This option is great 
when your paths are fairly simple with 
minimal overlap, but when the 
situation gets complicated you may 
have a very hard time figuring out 
which path or object is selected. Turn 
this option off to see only the current path.

• Display Text Outlines shows only the wireframe outline of your objects. Use this option 
with All Paths to see only outlines of every path in your animation.

Display All Paths

Display Text Outlines
Snapshot of All Objects

Snapshot of Selected Object
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• Snapshot of Selected Object provides a rendered bitmap of the current frame in time 
for the selected path only.

• Snapshot of All Objects provides a rendered bitmap of the current frame for all paths in 
your animation. Snapshot of Selected Object and Snapshot of All Objects are toggle 
buttons, so you can choose one display option or the other, but not both at the same 
time. 

2 To see exactly what your objects and text lines will look like throughout this tutorial, select 
Display All Paths and Snapshot of All Objects.

Step 4: Create Multiple Keyframes
1 Once you have selected an object, you need to add keyframes. Keyframes are the 

significant events that make up the points on the animation path. Every animation moves 
smoothly between keyframes along a particular path. To create a path, you need to define 
a starting point and an ending point, and any significant points of change in between. 

The Flying Text keyframe and the Oval object keyframe have a circled number 1 in the 
middle of them. This number refers to the order in which the keyframe will appear. 

2 Start with the Flying Text path, by clicking on it, 
then select Edit➝Insert Keyframe➝Before 
Selected Keyframe to add a single keyframe. Notice 
how keyframe 1 overlaps keyframe 2.  

3 To reverse the order in which the keyframes appear, click on the Reverse Path 
button on the Animation palette. The keyframe labels will change to reflect their 
new position in the path. 

4 To delete a keyframe, select the keyframe and press DELETE, or select Delete Keyframe 
from the Edit menu or the Right Click menu. If the path contains only 1 keyframe, 
TitleMotion will not let you delete it; you must switch back to the CG Editor to delete the 
object.

Step 5: Change the Position of Keyframes
1 When you have more than one keyframe defined for the current path, 

you need to change the position of one or both of the keyframes. Then 
animation moves the object along the path you define between the 
keyframes. 

2 Click on the keyframe you want to move. 

3 To reposition a keyframe click on the Position tool on the Placement tab, then 
drag the keyframe to a new position. The Position tool must be selected 
before you can move the keyframe. The cursor changes to indicate the nature 
of the current tool.  
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4 If you need precise positioning, type 
values into the Position fields on the 
Placement tab. 

In TitleMotion, position is defined by 
the X, Y, and Z coordinates. The X 
coordinate marks the horizontal 
position, the Y coordinate marks the 
vertical position, and the Z coordinate 
marks the depth. Keyframe positions 
are measured from the center point or 
focus point of the keyframe. 

5 For this example, each path should 
have 3 keyframes. Drag the keyframes into place so that the animation path looks like the 
paths in the graphic above.

Step 6: Preview Your Changes
It is important to preview the results even when you make a minor change. A change to one 
keyframe can affect the entire spline of a path, the timing, movement, and interaction of 
objects. 

1 The Preview toolbar is located on the bottom of the FX Editor window and provides 
different options for previewing your animation. The following graphic labels all of your 
viewing options. 

The preview options display the results in the FX Editor window. You cannot view the 
rendered animation on your video screen until you return to your NLE system.

2 For a basic preview, click on the green Go button on the toolbar, or choose Go! from the 
Go menu. TitleMotion will fly every path in your animation on your computer screen. 

From Current Keyframe  Next KeyframePrevious FrameSet Current Frame to 1

 Previous Keyframe Next Frame Forward to End Reverse From Current Frame

Go Button
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If the preview stops playing suddenly, your animation is probably longer than your source 
clip. If you look on the Time tab, you may see that part of the timeline has turned red. To 
fix the problem, make the path shorter by clicking on the end of the path and dragging it 
to the left. For more details see “Step 10: Adjust the Spline” on page 48. 

3 There are three options on the Go 
menu that affect the way the preview 
looks. Selected Object Only displays a 
preview of the selected path, Show 
Trails leaves a wireframe trail of each 
frame in the path, and Clip to Screen 
limits the display to the preview area 
representing you video screen.

Step 7: Apply a Motion Template
Motion templates are preset effects that you can apply to any object in the FX Editor window. 
All template settings are located on the Templates tab. 

End of Path End of Clip

Registry Management Template List Preview



TitleMotion 45 

1 First select the Oval object path.

2 Switch to the Templates tab. In the Template List, click on the template called “from left / 
to left.” The display to the right of the Template List provides a preview of what the 
template will look like applied to the selected keyframe. In this case, the white line 
indicates that the object will fly onto the screen from the left, and come to rest in the 
center of the screen. For information on adding a custom template to the list, skip ahead 
to point 7.

3 Before you apply a template, you need to choose 
options that change the way the effect looks when 
applied. These options include the Apply, Insert, and 
Timing values. 

Apply options concern the position where the 
template is inserted. These options are Overwrite, 
Relative, and Absolute. 

The Overwrite option eliminates all properties of the 
selected path and replaces them with the information from the template. 

The Absolute and Relative options determine whether any positioning information is 
used. If you choose the Absolute option, TitleMotion ignores the current position of the 
keyframes in the original path and forces the keyframes into the positions saved in the 
template. If you choose Relative, TitleMotion applies all other template attributes but it 
keeps the position of the selected keyframe. 

4 Insert options affect how and where the template is inserted into the current path. To 
reverse the stored preset keyframe order, select the Reverse checkbox. For this tutorial, 
the template you selected should fly onto the screen rather than off, so do not select 
Reverse.

The Before and After options determine where the template is inserted. If you select 
Before, the template is inserted before the entire original path, and if you select After, the 
template is inserted at the end of the original path.

5 You can also set timing options for the template. If you want the path 
to begin at a frame other than frame 1, just type the frame number 
into the Start field. To set the number of frames in the path, type the 
number into the Length field. Time is measured in frames, so you can 
increase or decrease the length by changing the frames value in the 
Length field. 

The Stagger option is unavailable until you apply a template to more 
than one object with the All Objects checkbox or the Count field. 
Stagger starts each path after a set number of keyframes. If you have 5 paths, and you set 
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the stagger value to 10, the first path begins at the Start frame, the second 10 frames later, 
the third 20 frames later, and so on. 

6 To apply the options you have set, click on Apply.  

7 When you apply a template to an object you can still make changes to any keyframe at any 
time. Use the preset template as your foundation then make as many changes as you like. 
Click on Add to add the template in the list.  

Click on Update to change the attributes of the template while 
keeping the name. To Rename a template click on the Rename 
button and type in a new name in the field provided.  If there is 
a template in the list that you never use, just select it then click 
on Delete to remove it from the list. TitleMotion will ask you to 
confirm all of your selections because there is no Undo for 
these functions.

Step 8: Change the Shape
You can change the shape of a keyframe in four ways: Extend, Skew, Twist, and Scale. The 
controls for all of these properties are located on the Shape tab, as well as on the Animation 
palette. Make sure you preview the results each time you change one of these properties.

1 Extend stretches an object on a particular axis. On the Shape tab, click on the 
Extend tool, then select keyframe 2 in the Flying Text path. Hold down the 
left mouse button and drag left or right to extend the keyframe on the 
horizontal or X axis, or drag up or down to extend the keyframe on the vertical or Y axis. 

2 Skewing slants the object on one or both axes. Click on the Skew tool. Select 
keyframe 3 in the Flying Text path. Hold down the left mouse button and 
drag up or down to slant the keyframe on the Y axis; left or right to skew the 
keyframe on the X axis. 
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Make sure you preview the results of your changes. Notice the way the object begins to 
slant before it reaches the keyframe you skewed. 

3 Twist adjusts the shape of the keyframe by twisting it around either the X or 
Y axis. Click on the Twist tool. Select keyframe 1 in the Flying Text path. Hold 
down the left mouse button and drag up or down to twist the keyframe on 
the Y axis; left or right to twist the keyframe on the X axis. 

You may find it hard to see how your keyframe looks 
with the shape adjustments applied.  For a different 
view, right-click on the Object view window and 
choose 3/4 view. Use the slider bar to the right of the 
Object view window to zoom in on the object. 

4 Click on the Scale tool, then select keyframe 2 in the 
path for the Oval object. Hold down the left mouse button and drag up to 
make the keyframe smaller, until it is so small you can hardly see it. The 
keyframe number will still be visible, but you will not be able to see the 
bitmap image because of the drastic size reduction. Now select keyframe 1 in the path for 
the Oval object. Again, hold down the left mouse button, but this time, drag down to 
increase the size. Your object will appear to “grow” from one keyframe to the next.

To force the values on the X and Y axes to match as 
you drag, select the Match Scale Values checkbox. To 
reverse the effect and “shrink” the keyframe, click on 
the Reverse Path button on the Animation palette.

Scale and Extend are similar functions. Scale actually 
increases the size overall as a multiplier. It also affects 
the offset because it changes the center of the 
keyframe. Extend adds to both sides of the keyframe but does not affect the offset or 
change the center of the keyframe. 

Step 9: Adjust the Axes
When you rotate, spin, or offset an object, you are really adjusting the behavior of the 
keyframe on a particular axis. The controls for all of these properties are located on the 

Match Values
  Checkbox
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Placement tab, as well as on the Animation palette. The instructions below step you through 
adjusting each effect separately. 

1 Offset moves the focal point of the shape to a new location. Select keyframe 2 
in the Oval path, then click on the Offset tool on the Placement tab.

Drag up or down to change the offset on the Y axis, or drag left to right to 
change the offset on the X axis. To change the offset on the Z axis, hold down both mouse 
keys while you are dragging.

The distance from the small 
square (the original point) 
to the where the line meets 
the keyframe indicates how 
far you have offset the focal 
point of the keyframe.

Offset becomes important 
when you are working with Orientation or Spins. When you rotate a keyframe, 
TitleMotion pivots the object around the focal point. By default, the focal point is in the 
center of the keyframe. When you change the focal point, the keyframe rotates around the 
new point you set.

2 Click on the Orientation tool, then select keyframe 2 in the Flying Text path.  
Hold down the left mouse button and drag left, right, up, or down to get a 
combination of rotation on the X, Y, and Z axes. 

If you changed the Offset, your keyframe no longer rotates around its center; it rotates 
around the focal point. To see the difference, drastically change the Offset for keyframe 2 
in the path for Flying Text. Now click on the green Go button on the Preview toolbar. Pay 
particular attention to the point around which the keyframe rotates. Now double-click on 
the Offset tool to reset it back to the default, then preview the animation once again. 

3 When you spin a keyframe, you force it to tumble end over end, around a 
particular axis. Spins is the only control in TitleMotion where you need to 
type the number directly into the coordinates fields. The number you type in 
is the number of spins you want. Type in a positive value on any axis for clockwise spins, 
or a negative value for counterclockwise spins. Note that when you set a spin, the spin 
occurs before the keyframe, on the spline leading into the keyframe.

Step 10: Adjust the Spline
A spline is a curve that is defined by the sum of the points between two keyframes. Which 
means what, exactly? Well, when you create more than one keyframe, TitleMotion 
automatically adds 1 second between keyframes. That second is then divided up into 
individual frames. The spline starts at the first keyframe, and ends at the last keyframe, but 
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includes all the frames in between. In the example below, the spline curve begins at keyframe 
1 and ends at keyframe 3, but all the frames in between define the curve.

There are three spline curves for every path: the Position spline, the Rotation spline, and the 
Shape spline, however only the Position path is visible in the FX Editor. 

1 Tension adjusts the rigidity of the spline allowing you to tighten or 
loosen the curve. For this example, adjust the tension on the Position 
spline. A change in tension is most obvious on a keyframe between 
two other keyframes, so select keyframe 2 in the Flying Text path.

Click on the slider and drag right to increase the tension on the curve and tighten the 
spline. Watch the display in the FX Editor window as you drag the tension slider. The 
spline curve effectively turns itself inside out when you drastically increase the tension.

Now drag to the left to decrease the tension and make the curve much slacker. The spline 
spreads out and is now shaped like a horseshoe. Type in a value of 1.00 for the tension in 
the field beside the slider. This will result in a straight line going into and out of the 
keyframe. To reset the tension value back to the default double-click on the slider button.

Spline C ur ve

Spline Sliders
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The graphic below provides examples for different tension values on a simple 3 point 
spline curve.

In most cases a change in tension, continuity, or bias affects the frames two keyframes 
before and two keyframes after the keyframe you alter. 

2 The continuity of a spline affects the smoothness of the path coming into and out of the 
keyframe. Select keyframe 2 in the Oval object path and drag right to decrease or left to 
increase the continuity. 

A drastic increase in continuity creates a swooping effect coming into and out of the 
keyframe. A decrease in continuity creates a bumpy effect coming out of the previous 
keyframes, and going into the next keyframe. Type a value of -1.00 in the field beside the 
continuity slider to create a straight line going into and out of the keyframe. To reset the 
continuity value back to the default click on the reset button to the right of the slider.

The graphic below provides examples for different continuity values on a simple 3 point 
curve. If you compare the results to the tension graphic above, notice how continuity 
creates almost the opposite effect of tension.

3 Bias weights the motion coming into or out of a keyframe. TitleMotion averages the two 
values, and creates an even motion coming into and going out of the keyframe. If you 
increase the bias, you weight the average toward the motion coming out of the keyframe, 
whereas if you decrease the bias, you weight the average toward the motion coming into 
the keyframe. Take a look at the diagram below to see how the spline changes when you 
set different bias values. 

Tension = 0Tension = -5 Tension = -1 Tension = +1 Tension = +5

Continuity = 0Continuity = -5 Continuity = -1 Continuity = +1 Continuity = +5

Bias = 0Bias = -5 Bias = -1 Bias = +1 Bias = +5
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Instead of using the slider, you can also type a value for the bias in the field beside the 
slider. To reset the bias value back to the default double-click in the Bias number field.

4 You can adjust the tension, continuity, and bias in conjunction with the Ease In and Ease 
Out values (also located on the Spline tab). Adjust the Ease In value to increase or 
decrease the speed into the selected keyframe, and adjust the Ease Out value to increase 
or decrease the speed coming out of the selected keyframe. 

5 All your experiments so far used the Position spline. That is because it is the only spline 
where you can see the results of the change in the FX Editor window. 

You can only see the results of a change in the Rotation spline when you set a Spin or 
change the Orientation of a keyframe and then preview the result. The changes in the 
Rotation spline are not visible unless the display is moving.

In the same way, you can only see the results of changing the Shape spline when you 
change one of the values on the Shape tab (Extend, Skew, Twist, or Scale) and then 
preview the result.

Step 11: Apply Special Filters
Filters are special effects that you can apply to a keyframe to change the way the object looks 
over time. Filters include Transparency, Crop, Mosaic, Luminance, and Tint. All filters are 
located on the Filter tab.

You will not be able to see the effect of these filters in the Preview window. They are only 
visible in rendered animations.

1 Switch to the Filters tab. Each filter has its own values and properties to set. For each of 
the examples below, you will only see the results if you return to your NLE system and 
render the animations for playback.
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2 Transparency changes the alpha value of the object over time, which 
means you can fade an object in or out between keyframes. Select 
keyframe 3, then type in a transparency value of 75%. When the 
animation plays, the object will become more transparent as it moves 
from keyframe 2 to keyframe 3. This effect is great for completely fading 
an object out over time, or for making an object appear on the screen 
gradually over time.

3 Crop cuts off a percentage of the selected object. You 
can set a different crop value for each side of the 
object. Select keyframe 2 in the Oval object path. 
Enter a crop value of 10% in the Top field, and a 
value of 25% in the Right field. 

4 Mosaic makes the object more or less pixelated over 
time, so that it appears to be made up of large 
squares instead of tiny pixels. Select keyframe 1 in the Flying Text path. Enter a percentage 
value of 100 in the Mosaic Height field and a value of 100 in the Mosaic Width field. Now 
Select keyframe 2 in the Flying Text path. Enter a percentage value of 0 in both the Mosaic 
Height and Width fields. This effect starts out with a very pixelated object that becomes 
gradually clearer as it moves through time to keyframe 2. This effect is normally used to 
blur out an object on screen.

5 Luminance adjusts both the brightness and the contrast values of the object over time. 
Select keyframe 2 in the Flying Text path, and type a value of  20 into the Brightness field 
and a value of 10 in the Contrast field. A large luminance value makes the object appear to 
glow.

6 Tint allows you to gradually change the saturation of your object from black and white to 
color, or to change the object from one color to another between keyframes. Select 
keyframe 2 in the Oval object path, then type a value of 82 into the Tint field, 100 in the 
Hue field, and a value of 61 in the Saturation field. 

7 You may want to return to your NLE system to render the image and see the effect of the 
filters. Check the Interface Addendum for details.

Step 12: Change the Graphics and Text
1 You can change the attributes of your text and draw objects at any time, but you have to 

switch back to the CG Editor to do so. Click on the CG Editor button to switch back to the 
CG Editor. The CG Editor window will open up on top of the FX Editor window. 

2 Once you edit your objects click on the Animation button on the CG toolbar to switch back 
to the FX Editor window. Your edited objects appear in place. All previous changes you 
made to your animation remain intact. 

Top
RightLeft

Bottom
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Step 13: Set the Timing
Since time is measured in frames, the timing of your animation depends on the number of 
frames in each path. You can adjust the length, point in time at which the path runs, amount 
of time between keyframes, or the start and end frames of the path. 

For preview purposes, the current point in time for each path is surrounded by a green 
outline on your display. You can scroll through time using the Time slider on the Preview 
toolbar. 

1 Switch to the Time tab to access all controls for setting the timing of your animation. If 
you followed the tutorial so far, your timelines should look fairly similar to the one in the 
labeled diagram below. 

The first thing to note is the difference between adjusting the length of a path and merely 
shifting the path along in time. To adjust the length of a path, you add frames either 
across the entire path or between keyframes. To shift the path in time, you change the 
start and end frames without adding any extra frames.

2 There are two ways to adjust the length of a path. First, grab the right edge of the slider 
bar in the timeline for the Oval object and drag it to the right to increase the number of 
frames in the animation. Notice that the numbers in the End and Total frames fields 
change as you increase the length (number of frames) of the path. To decrease the length 
of the path, grab the left edge of the slider bar and drag to the left to decrease the length of 
the path. 

Time SliderCurrent Frame

End of Path Clip Length

Zoom In Zoom Out

Start Frame Field
End Frame Field
Duration

All Paths
End Frame
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You can also add a delay at a keyframe that will increase the total length of 
the path. Select keyframe 2 in the Flying Text path, then add 15 frames in 
the Pause field. The number in the End and Total frames fields will also 
change because TitleMotion adds the number of frames in the Pause field 
to the number of frames in the rest of the path. Adding a pause between 
keyframes forces TitleMotion to stop and hold at a keyframe for a set 
number of frames before the path continues on to the next keyframe. In 
this instance, when the path reaches keyframe 2, it will stop and hold for 
15 frames, then continue on to keyframe 3.

You may have noticed that the number of frames in the All Paths field changes when you 
adjust the length of a path. This number is calculated based on when the last object in the 
animation is complete, and indicates how long your animation will take overall, not per 
path. If you have really long paths in your animation, that is with a lot of keyframes and 
therefore many frames, you may have to use the horizontal and vertical slider bars to see 
all paths and the entire timeline. 

3 Instead of increasing or decreasing the length of your path by adjusting the number of 
frames, you can simply shift where the animation occurs over time. Use this method of 
changing the time if you want one path in the animation to start flying later than the other. 
You can start a particular path at any frame by changing the number in the Start Frame 
field, or by using the slider to shift the entire timeline forward. Instead of grabbing either 
the left or right side of the time slider, click on the center of the slider for the Oval object 
path, hold down the left mouse button and drag to the right. The Start and End Frame 

Vertical Slider

Horizontal Slider
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fields change to indicate at which frame the path begins and ends. The entire slider moves 
along in time, but the number of frames in the path remains the same. 

4 If your NLE editor supplies a source clip to TitleMotion, you will see the total clip duration 
marked on the timeline. If any path runs past the clip length, the timeline will turn pink 
to identify the problem. You can fix the problem by making the path shorter or starting it 
earlier in the animation. If you do not fix the problem before you return to your NLE 
system, the animation will be cut off at the end of the clip when you renderer it out for 
viewing.

5 When you return to your NLE system, you may find that you need to adjust the 
length of the animation. The Clip Options determine what will happen to the 
animation. 

• If Scale to Fit the Clip is selected, the animation will be 
scaled to match the change in effect length. It can be made 
longer or shorter. 

• If Crop on the Right is selected, the end of the animation will 
be cut off if you make the effect shorter. If you make the 
effect longer, the animation will not be affected. 

• If Auto Select the Method is selected, the animation will be 
scaled if it is the same duration as the clip. It will also be 
scaled if the animation appears in the middle of the clip. If the animation is aligned 
with only one end of the clip, it is not scaled. This is the situation where you have flown 
objects in at the beginning of the clip or flown objects off at the end of the clip. For 
more details on scaling objects, see “Change Shape Attributes” on page 106.

6 You can also set a couple of timing options that affect rendering of the animation. The 
push pins beside each of the paths in your animation force TitleMotion to leave a path on 
the screen until the entire animation is complete. For example, in the following graphic 
note that the Oval object path ends at a frame in time before the Flying Text path. If you 

Path Shifted in Time
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render the animation in its current state, you will see that when the Oval object path 
reaches its end point, it simply disappears from the screen. 

If you click on the push pin for the Oval object path, the last frame in the animation will 
remain on the screen until the last frame in the Flying Text path. When the push pin is 
pointing down as though it is “pinning” the path in place, the path will remain on screen 
until the end of the animation. When it is pointing sideways, the path will disappear when 
it reaches its last frame.

Step 14: Rendering 
Animations are only rendered in your NLE system. When you close TitleMotion, the 
animation is placed in the timeline or bin or library in a form that requires rendering for 
playback.

1 You can limit which paths you include in your animation. Switch to the Time tab and look 
for the Render Path checkboxes. Each path has its own checkbox. By default, all paths are 
checked to include them in the render. If you do not want to include a path, click in the 
checkbox beside the path you do not want to include. An empty checkbox indicates that 
the path is rendered in the animation. 

2 Note only items within the preview area are rendered. Any keyframes, or parts of 
keyframes outside this area are not included in the render. This reduces render time and 
the amount of RAM consumed, but it still produces the fly on or fly off effect.

Render Path
Lock Path

Remain on Screen
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How To…
How To…topics offer step-by-step instructions for completing common tasks in TitleMotion. 
If you work through these procedures, you should have a good understanding of how the 
program functions.

The Notes and Tips at the end of some of the topics give additional information and 
suggestions for using the program efficiently.

If you prefer, the How To… topics are also available online. They appear in a separate window 
that is always on top of TitleMotion so that you can use the program while the help is 
displayed.

The following topics are included in this How To... section.

• Fundamentals • Use Tools

• Format Text • Work with Keyframes

• Format Graphics • Use Preview Options

• Set Backgrounds • Change Keyframe Attributes

• Change Colors • Adjust the Spline

• Create and Use Logos • Use Filters

• Apply Templates • Use Motion Templates

• Set Screen Markers • Set Timing Options

• Define Animation Layouts • Render Animations
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How To... Fundamentals
These topics describe the essential concepts you need to run TitleMotion. They also include a 
number of shortcuts that will save you a lot of time. 

Use Quick Number Selection
1 Click in any number field.

2 Drag the mouse up to 
increase the value or down 
to decrease the value.

3 Double-click in the 
number field to reset the 
default value.

Enter Text
The square brackets mark the current line. When you type, 
text is inserted on the current line. The flashing cursor marks 
the current point, so when you type, text is inserted at the 
cursor. 

The brackets marking the current line have one vertical line if the text is formatted with a 
color group. The brackets have two vertical lines if the text is formatted with a style group.

Choose a Style or Color Group
1 Click on the text line to format.

2 Click on one of the style groups from the bottom 
section of the CG palette. These are chips 9 to 16. 

3 Change the colors or style as appropriate.

Notes
• There are 16 more styles available on the Styles tab for 

a total of 32 styles.

• Lines formatted with a color group are marked with 
square brackets; lines formatted with a style group are 
marked with double square brackets.

• Lines of text that share the same style group have the same font, height, width, shadows, 
edges, kerning, small caps, and slant. They also share the same foreground, edge, and 
shadow colors. Lines of text that share the same color group only share the color definitions.

Click on the up and down arrows
to change the value by one unit.

Click in the field and drag the mouse
up and down to quickly change the value.

Text entry starts here

Style Groups

Color Groups
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Create a Text Line or Graphic Object

Text
1 Click on the Text button on the CG Palette or on the Text 

button (the first button) on the CG Toolbar.

2 Start typing.

3 To create a second line, press ENTER.

Draw
1 Click on any draw shape on the CG 

palette.

2 Click on the starting point in the working 
area and drag the mouse to the opposite 
corner. The shape will appear when you release the mouse.

3 To create a second graphic, repeat step one.

or

To duplicate the current graphic object, press ENTER. The duplicate will appear just below 
and to the right of the existing one.

Select the Next or Previous Item
There are three ways to select text lines or graphic objects with the keyboard or mouse. Use 
the option that is convenient. TitleMotion uses the baseline position to identify the next and 
previous items.

Option Method

Toolbar Click on the Move Up and Move Down buttons

Keyboard Use up and down arrow keys

Mouse Click on a line

Text Draw
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Select a Layout Type
Select the layout type from the Layout Type drop-down list. If you cannot select a layout type 
from this list, your NLE system sets the layout type before opening TitleMotion. Check the 
Addendum for your NLE system for more information.

Access ANSI Characters
The ANSI character set includes characters that are not available on all keyboards. The precise 
set of characters you can type from the keyboard depends on the Keyboard Layout setting in 
the International Control Panel.

1 Choose Character Map from the Edit Menu.

2 Click on the character you want to insert.

3 Click on Backspace to delete the last character in the line.

4 Click on OK to return to the CG Editor window.

Layout Result

Still Single page layout created.

Roll Multiple page layout created. When displayed, text smoothly rolls 
from the bottom to the top of the screen.

Crawl Multiple page layout created. When displayed, the text appears in 
a thin strip and runs from one side of the screen to the other.

Animation Single page layout created. To add motion to the objects, switch to 
the FX Editor window.



TitleMotion 61 

Move a Text Line
1 Click on the line you want to move.

2 Press CTRL and drag the line to a new position. Tab-constrained lines will only move 
vertically. Non tab-constrained lines will move vertically and horizontally. Press 
CTRL+TAB to convert a line from tab-constrained to non tab-constrained.

3 Press the ALT key and use the cursor keys to move the text line by one pixel or scan line.

4 Click on the Move Up and Move Down buttons on the CG toolbar to move the line by one 
line position. Press CTRL when you click on the button to move the line by 10 scan lines. 
Press SHIFT when you click on the button to move the line by 1 scan line.

Notes
• By default, when you move one line, all 

the rest of the lines remain in place. To 
move the selected line and all the lines 
underneath it as a block, choose 
Element➝Constrain➝Locked Lines.

Use Vertical Typing
Vertical typing is normally used for double-byte languages.

1 Choose Element➝Vertical Text Processing to enable vertical text processing. The cursor 
will move to the right side of the screen for text entry.

2 Enter text as you normally do.

Move Up Move Down
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Notes
Each layer uses either horizontal or vertical text processing. You cannot use both types of text 
on a single layer. If you want both types of text in a single layout, put the text on different 
layers.

Move an Object Between Layers
1 Click on the text line or graphic object to move.

2 Choose Element➝Layer Control➝Pull to 
move the object up one layer.

3 Choose Element➝Layer Control➝Push to 
move the object down one layer.

4 Choose Element➝Layer Control➝Layer List 
to display a window showing all the layers.

Notes
Layers are numbered from 1 to 5. Layer 5 is on top of all other layers; layer 1 is below all other 
layers. As a short cut, click on a text line and hold down SHIFT+CTRL while you drag the line to 
a new layer. The cursor will show you the current layer as you drag.
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How To... Format Text
This section describes how to use the typographic controls available in TitleMotion. It begins 
by explaining Style and Color groups, an essential text formatting concept. Most of the text 
formatting options are located on the Size & Attributes tab.

Change the Format of a Style or Color Group
Lines of text that use the same style group have the same 
font, height, width, shadows, edges, kerning, small caps, 
and slant. They also share the same foreground, edge, and 
shadow colors. Lines of text that share the same color 
group only share the color definitions.

1 Click on the line of text you want to change.

2 Click on a Color Group or Style Group on the CG 
Palette.

3 Change the format on the Size & Attributes tab.

See Also
“Step 3: Applying Local Formatting” on page 35

“Change the Color of a Style or Color Group” on page 64

Format Type What Will Change

Style Group All the lines in the layout that use the same style.

Color Group Only the current line or text.

Style Groups

Color Groups
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Change the Color of a Style or Color Group
1 Click on the line of text you want to change.

2 Select a Color Group or Style Group on the CG palette.

3 Switch to the Color & Texture tab.

4 Select the part of the character to change and use the RGB, HLS, or HSV color model to 
select a new color.

See Also
“How To...Change Colors” on page 84

“Step 3: Applying Local Formatting” on page 35

“Change the Format of a Style or Color Group” on page 63

Select Text Colors
1 Click on the line of text to modify.

2 Select a color group or style group 
from the CG palette.

3 Switch to the Color & Texture tab.

4 Select the part of the character you are 
formatting: foreground, edge, or 
shadow.

5 Choose a color using the Square Color Selector and the slider control. If you are defining a 
color blend, make sure Top or Bottom is selected on the Color Blend Chip instead of Solid.

See Also
“How To...Change Colors” on page 84

“Step 3: Applying Local Formatting” on page 35

Reference: Defining Colors (online)

Format Type What Will Change

Style Group All the lines in the layout that use the same style group.

Color Group All the lines in the layout that use the same color group.
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Apply Local Formatting
Use local formatting to change the colors or text formatting of a few letters or words without 
making the change to all the lines in the layout that share the same color or style group.

1 Use the mouse to select the letters or words you want to change. Selected text has a white 
outline.

2 Make the color or text formatting changes you want to make.

3 Click anywhere else in the layout to deselect the text

Tip
• Double-click on a word to select it.

• The Format Sample on the CG palette shows a “+” symbol beside 
the style or color chip number when the current letter uses local 
formatting.

• You can convert local formatting to a style or color definition by 
dragging from the Format Sample on the CG palette to any style or color definition chip on 
the CG Palette.

See Also
Reference: Local Formatting (online)

Reference: Automatic Update (online)
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Choose a Typeface
1 Click on a line of text to modify.

2 Select a typeface name from the Font list on 
the Size & Attributes tab.

or

3 Choose Font from the Attributes menu, and 
select the typeface you want.

Notes
• To see a sample of the each font in its typeface, 

click on Browse on the Size & Attributes tab.

Modify a Font
1 Click on the line of text to modify.

2 Click on the B (bold), I (italic) button on the Size & 
Attributes tab.

Change the Text Size
1 Click on the bounding bracket for the line you want to change. Click the top corner to 

change the height or the side to change the width.

2 Drag the mouse up or down to change the height. The width will be automatically 
adjusted to match the new height.

3 Drag the mouse left or right to change the width without changing the height.
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Notes
• You can also change the width and height on the Size & Attributes tab.

• If you change the height after you set the width, the width may be adjusted slightly because 
of mathematical rounding.

• To change the height and the width at the same time, click on the Freeform Sizing button 
on the Size & Attributes tab.

Add a Shadow
1 Click on the text line to change.

2 Choose a shadow type and size from the Size & 
Attributes tab.

3 Set the shadow direction from the direction options 
arranged in a circle.

4 If you are using a soft shadow, set the shadow 
softness. A bigger softness value gives a more diffuse edge.

Notes
• Drop and extrude shadows look the same until you apply a color blend. They apply color 

blends in different directions.

• Offset and soft shadows look the same until you increase the Softness setting.
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Add an Edge
1 Click on the line of text to modify.

2 Choose an edge size and type from the Size & Attributes tab.

See Also
“Create Embossed Text” on page 68.

Create Embossed Text
This effect requires that the text foreground color matches the background color. It works best 
with large text characters.

1 Select a background color.

2 Create the text to emboss.

3 Add 2 to 5 pixels of embossed edging using the Edging option on the Size & Attributes tab. 
Make sure to select the Emboss radio button.

4 Switch to the Color & Texture tab and choose the HLS color model.

5 Make the text foreground and the edge the same color as the background. (You might 
want to use the Eyedropper tool to sample the exact color.)

6 Click on the Edge Chip and then click on the Color Blend Chip until Top is selected. 
Increase the Lightness (L) by about a value of 5.

7 Click on the Color Blend Chip until Bottom is selected. Decrease the Lightness (L) by 
about a value of 5.

8 Finish embossing the text by adjusting the top and bottom edge colors as necessary.

Tip
If you are having trouble selecting foreground and edge colors, try using these colors. Choose 
a serif font with fairly thick characters. The colors are given for all three color definition 
models. 
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For further experiments, try changing the size of the embossed edge. With some color 
combinations you can reverse the embossed effect and make the letters look pushed into the 
background by reversing the edge colors and making the top edge color darker than the 
bottom color.

Cut Text Through to Video
The transparency setting makes text 
transparent to what is behind it. This 
means you see the edge or shadow 
through the foreground. To cut through 
to background video, use the Video 
setting.

1 Create your text as usual.

2 Set an edge or shadow or both.

3 On the Color & Texture tab select FGND property.

4 Click on Video to cut through.

Create Slanted Text
1 Click on the line of text to modify.

2 Switch to the Size & Attributes tab.

3 Select a new angle for Slant.

Notes
• Standard italic fonts use 9 to 15 degrees of slant.

Element HSV RGB HLS

background (7,35,72) (184, 127, 118) (7, 59, 31)

foreground (7, 35, 72) (184, 127, 118) (7, 59, 31)

edge top (7, 28, 76) (184, 144, 139) (7, 65, 31)

edge bottom (7, 47, 57) (145, 83, 77) (7, 44, 31)

Select FGND

Click on Video
  to cut through

Slant Type Slant Value

Left Use a negative slant value.

Right Use a positive slant value.
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• Standard italic fonts change the shape of some letters. Slant text keeps the same letterforms. 
Check the “f ” and “a” in the graphic below.

Apply Small Caps
1 Type the line of text using 

normal mixed case (upper and 
lower case letters).

2 Switch to the Size & Attributes 
tab.

3 Set the size of the Small Caps.

For example, a Small Caps value of 80% converts the lower case letters to upper case, but 
shows them at 80% of the size of normal upper case letters.

Change the Kerning
Kerning affects the spacing between letters. If the maximum kerning value is not enough, try 
adding an extra space between the letters. In the image below, extra kerning was applied to 
“information” so that its width would match the width of “Community”. You can also kern a 
single pair of letters.

Text Type Small Caps Value

Mixed Case Leave Small Caps at 0%

All Upper Case Set Small Caps to 100%

Small Caps Set Small Caps to a percentage 
of full upper case letters.
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Kerning an Entire Line 
1 Click on the line of text to modify.

2 Change the Kerning value on the Size & Attributes tab to adjust the letter spacing. To 
increase the spacing increase the value. To decrease the spacing, decrease the value.

Kerning a Pair of Letters 
1 Position the cursor 

between the two letters 
you want to adjust.

2 Use the keyboard 
controls to move the 
two letters.

Change the Leading
Leading sets the amount of space between two lines of text. In 
the image on the right, the leading is the space between the 
bottom of the “y” and the bottom of the bounding bracket. The 
first “Áy” uses 8 scan lines of leading; the second “Áy” uses 20 
scan lines of leading. Larger leading values leave a larger space between the lines. 

1 Click on the line of text to change.

2 Switch to the Size & Attributes tab.

3 Change the leading value. The brackets around the selected line show you the leading for 
new lines.

Notes
• To reposition the other lines in the layout, choose Element➝Apply Leading . This moves 

the lines to remove the overlap and extra spaces.

Underline Text
The most flexible way to underline text is with graphic objects.

1 Click on the Rectangle object on the CG 
Palette.

2 Click on the starting point for the underline 
and drag the mouse to the end point.

3 Add a bevel edge to the rectangle, if you want.

4 To move the rectangle, press CTRL and drag it to a new position.

Kerning Keystrokes

Increase Kerning Press CTRL+PLUS on the number pad

Decrease Kerning Press CTRL+MINUS on the number pad
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Align All Text Lines
1 Create the lines of text you want for the layout.

2 Choose an alignment option from the 
Element➝Align All menu.

Notes
• To align a single line, press TAB to move 

the text to the appropriate tab position.

• These alignment setting are only correct if 
you have not changed the default tab 
types. This will be the case for any layouts 
based on the templates shipped with TitleMotion.

Center Text
To center a single line, press tab twice at the beginning of the line. Several layout templates 
start with centered lines.

Center Text Vertically 
1 Create and format the text to center.

2 Choose Center Vertically from the Element➝Align All menu.

This process keeps the space that exists between lines of text. If you want to get rid of any 
extra spaces between the lines, choose Apply Leading from the Element menu before 
centering the text.

Center Text Horizontally
Text alignment is handled with tabs. These instructions work if you are using a layout with 
default tabs. 

Lines Method

Center one line Move to the beginning of the line and press TAB twice

Center all lines Choose Center Tab from the Element➝Align All menu

Option Result

Left Tab moves line to tab 1

Center Tab moves line to tab 3

Right Tab moves lines to tab 5
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If you are using a modified layout template, check the tab alignment in the Edit Tab Position 
& Alignment dialog box.

1 Switch to the View tab.

2 Click on the Tab Stops Edit... button to display the Edit Tab Position & Alignment dialog 
box.

3 Make any required changes to the tab stop locations or their alignments.

4 Click on OK.

Use Floating (Non Tab-Constrained) Lines
A non tab-constrained line can move anywhere on screen. These lines are marked by a 
bounding rectangle in place of square brackets.

1 Click on the line to covert to non tab-constrained.

2 Press CTRL+TAB.

3 Hold down CTRL, click on the line, and drag it into position.

To convert a line back to tab-constrained, press CTRL+TAB again or choose Text to Tabs 
from the Element➝Constrain menu.
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Wrap Text as You Type
1 Choose Word Wrap from the Element➝Constrain 

menu.

2 Format the text line and begin typing or paste text 
from the clipboard.

3 When a word does not fit within the safe title area, 
it will move to the next text line.

Word wrap does not automatically move words backward to fill holes. To force the text to 
reflow, press BACKSPACE at the start of a line.

Import Text
If you are creating a long roll, you may find it easier to create the text in your word processor 
or text editor and import it into TitleMotion.

1 Position the cursor where you want to insert the text. Format the line if necessary.

2 Choose Word Wrap from the Element➝Constrain menu.

3 Choose Import Text File from the File➝Import menu.

4 Select an ANSI format file and click OK.

TitleMotion can import ANSI text files created with WordPad, Notepad, or other ANSI text 
editors. Files created with a word processor must be exported as plain text to import correctly.

Remove Spaces Between Lines
1 Click on the first line of text in the layout.

2 Choose Apply Leading from the Element menu.

TitleMotion will redraw text lines so that the line positions touch but do not overlap. Any extra 
space will be removed and overlapping lines will be repositioned. Apply Leading starts at the 
current line. The lines above the selected one will not move.
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Move Locked Lines
1 Choose Locked Lines from the Element➝Constrain 

menu. When Locked Lines is selected, text lines 
automatically move to eliminate spaces and 
overlapping lines.

2 Choose Locked Lines again to turn the feature off.

Drag from One Group to Another
You can drag style and color definitions from one group to another.

Action If Locked Lines is On

Insert a new line Moves all lines below down to create a space.

Delete a line Lines below move up to fill the space.

Move a line Moves selected line, and all those below, 
maintaining relative spacing.

Source Target Result

Color Group Color Group Only colors are copied.

Style Group Style Group All formatting, and color attributes are copied. If you 
press CTRL while you drag, only colors are copied.

Style Group Color Group Only the colors are copied.

Color Group Style Group Only the colors are copied. If you press CTRL while you 
drag, the formatting from the current line is copied 
along with the color attributes.

Format Sample Color Group Only color attributes are copied.

Format Sample Style Group All formatting and color attributes are copied.
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How To... Format Graphics
There are two types of graphic objects in TitleMotion layouts. The basic objects (rectangles 
and panels) are used to enhance the text display with lines and boxes. Logo objects allow you 
to display small bitmap images.

The formatting options for graphic objects are located on the Size & Attributes tab. The 
options on this tab are different from the ones on the tab when you are working on text 
objects.

Create a Graphic Object
1 Click on a graphic shape on the CG palette.

2 Hold down the left mouse button, click on the starting 
point for the graphic, and drag until the object is the 
desired size.

3 Click on a color group or a style group on the CG palette 
to format the object.

4 If necessary, change the edging, bevel, and rendering 
options on the graphics Size & Attributes tab.

5 Resize the object as necessary.

Resize a Graphic Object
1 Click on the graphic object to resize.

2 Click on a grab handle on the corner of the bounding rectangle and drag it to a new 
position.

or

3 Select the Size & Attributes tab and set specific width and height values with the 
Horizontal and Vertical values.

Style Groups

Color Groups

Graphic Objects
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When you drag an object, you can use keys to force the object to a specific aspect ratio.

Move a Graphic Object
1 Click on the graphic object you want to move.

2 Hold down the left mouse button and drag the object to a new position on the screen.

3 While you drag, you will only see the bounding rectangle for the graphic object. When you 
release the mouse button, TitleMotion will redraw the object.

Notes
• You can set the Baseline and Left Edge positions on the View tab. Baseline is measured in 

scan lines from the top of the display. Left edge is measured in pixels from the left edge of 
the display.

• You can also use the cursor keys to move the current text line by a single pixel or scan line. 
Click on the line to move and use ALT+UP, ALT+DOWN, ALT+LEFT, and ALT+RIGHT to move 
the line.

Add a Beveled Edge
Rectangles, vertical panels, and horizontal panels are the only graphic 
objects that accept a beveled edge.

1 Click on the graphic object to bevel.

2 Click on Flat, Round, or Tube on the Graphics Size & Attributes tab.

3 Set the size of the bevel in the Edging field.

By default, the shading on bevels comes from a light source in the upper left corner of the 
screen. To change the lighting direction, grab one corner of the bounding rectangle and pivot 
it about the opposite corner. You will see the darker and lighter bevel positions change.

Drag Modifiers Functions

CTRL Force 4:3 aspect ratio.

SHIFT Force 1:1 aspect ratio.

CTRL+SHIFT Maintain the current aspect ratio.
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Stack Graphic Objects
You may need to adjust the object position in the stack when you have several graphic objects 
piled on top of one another.

1 Click on the graphic object that you want to send behind or bring to the front.

2 Choose Send to Back or Bring to Front from the Element menu to position the graphic.

or

3 Right click on the object and choose an option from the menu that pops up.

Apply a Logo to a Graphic Object
1 Click on a Logo shape on the CG Palette. A bounding rectangle will 

appear with the word LOGO inside.

2 Switch to the Logos tab.

3 Double-click on an empty space in the Logo Map to call the Open 
Image dialog.

4 Select a bitmap image to display as a logo and click on OK.

5 Resize the graphic as needed.

Option Result

Send to Back Puts the object under all the others in the pile.

Bring to Front Puts the object on top of all the others in the pile.
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Notes
• If the logo is in .lgo format, the shadow you apply will follow the internal curves of the logo 

image. If the logo is in any other bitmap format, the shadow you apply will follow the 
rectangular bounding box.

• You can convert any image to .lgo format in the Logo Compose module.

Change the Draw Rendering
1 Click on the graphic object you want to change.

2 Choose a rendering option on the Graphics Size & Attributes tab.

Select Graphic Object Colors
1 Click on a graphic object. 

2 Select a Style or Color Group from the CG Palette.

3 Switch to the Color & Texture tab.

4 Select the part of the graphic object you are 
formatting; Foreground, Edge, or Shadow.

5 Choose a color. If you are defining a color blend, make sure Top or Bottom is selected.

Notes
• The color change will be applied to all of the graphic objects that share the same color 

group or style.

• If you want to change the color of the selected graphic without changing all the other items 
that share the same color group or style, right-click on the style or color group on the CG 
Palette and turn Freeform Style on.

See Also
Reference: Color Definition (online)

Render Type Result

Normal The graphic object blocks the background or video clip 
underneath it. If the object is semitransparent, the video clip will 
show through the graphic object.

Background The object cuts through the background layer, no matter what 
other graphic objects are underneath it. If the background is a 
video clip, this cuts through to the clip.
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Create a Semi-Transparent Object
1 Select or create a draw object.

2 Change the Top and Bottom Transparency options on the Color & 
Texture tab. 

A value of 0% is opaque; a value of 100% is completely transparent. The 
settings in the graphic to the right define a semitransparent object. The 
top of the object is slightly more transparent than the bottom.

Notes
• A transparent object shows what is underneath it. If you want transparency to the 

underlying video clip, you must have a 100% Video Background.

• You can change the area and angle of the blend with the Top and Bottom Gradient values.
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How To... Set Backgrounds
Most NLE systems provide a frame from the source clip on your NLE timeline as the 
background in the CG Editor window. If no clip is available, TitleMotion fills the background 
with a pattern. Sometimes this pattern is a checkerboard of dark and light gray; sometimes it 
appears black. When you return to your NLE system and render or playback the timeline, the 
background will be replaced by a clip.

You can replace the video background with a solid color or a color blend, or you can import 
any bitmap image as a background. This section describes how to use the various options on 
the Background tab in the CG module.

All the controls for setting a background are found on the Background tab.

Set a Video Background
If you are using the Default template, you already have a video background. Use this 
procedure to create a semitransparent background, or to reset a background.

1 Switch to the Background tab.

2 For a full video background, click on 100% video. This is the default in many templates.

3 For a semitransparent background, set Top and Bottom Video Transparency to a value 
between 0 and 100% transparent. Make the values equal.

4 To change the area of the blend, change the Top and Bottom Gradient values.

Notes
• Video transparent areas are filled with a gray checkerboard, small blue dots, or a pattern 

that you choose, so that they look different from black areas. You can change the pattern by 
choosing File➝Preferences and changing the option on the General tab.

See Also
“Create a Transparency Gradient” on page 86
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Select Background Colors
1 Switch to the Background tab.

2 Choose a color. If you are defining a color blend, 
make sure Top or Bottom is selected.

3 To change the area of the blend, change the Top 
and Bottom Gradient values.

See Also
“Use a Color Model” on page 84

“Use the Eyedropper” on page 85

“Create a Color Gradient” on page 85

Reference: Color Definition (online)

Add a Pattern to a Color Background
1 Switch to the Background tab.

2 Select a color gradient or a solid color for the background.

3 Choose a pattern from the Pattern list.

4 Choose a pattern size: 1 gives a small pattern and 10 gives a large pattern.

Notes
• If you set a background color blend, the pattern elements will use an average color, not the 

blend.

Import a Bitmap as a Background
1 Switch to the Background tab.

2 Click on the Image box.

3 Select an image in the Open Image dialog and click on OK.

To stretch images to fit the full screen, select Size To Fit. If Size to 
Fit is not selected, images will appear tiled.

Image box
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Strip Alpha from an Imported Bitmap
This only applies to imported background images in formats that include alpha information.

1 Select Ignore Alpha on the Background tab.

2 Click on the Image box to open the Open Image dialog. Select an image and click on OK.

3 When the image is loaded, all of the alpha information contained in the image will be 
ignored.
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How To...Change Colors
The color definition process looks a bit complicated because TitleMotion gives you a choice of 
three different color models (RGB, HLS, and HSV). Choose a color model you are comfortable 
using and ignore the other two sets of options. The color selection mechanisms on the Color 
and Background tabs are identical. You can practice these processes on either tab.

You can find the color selection controls on the Color & Texture tab and on the Background 
tab. The color options are identical on both tabs.

When you are formatting text and graphic objects, remember to select the object element 
(foreground, edge, or shadow) to change before you start choosing a new color.

Use a Color Model
1 Select the Color & Texture tab or the Background tab.

2 Choose RGB from the Color Model list.

3 Click on the R, G, or B button to select a color component.

4 Move the controls in the slider and Square Color Selector until the color chip below the 
controls shows the color you want. The colors in the slider and square depend on the 
component you select.

Notes
• All three models work the same way. The options for the selected component appear in the 

slider strip; the other two components are displayed in the slider square.

• If you know the values you want, you can type the numbers into the number fields.

See Also
Reference: HLS Color Model (online)



TitleMotion 85 

Use the Eyedropper
1 Select the text or graphic object property to define. If you are defining a 

gradient blend, make sure that the correct Top or Bottom option on the 
Color Blend Chip is selected.

2 Click on the Eyedropper tool and drag it to an item of the color to 
match. You can select a color from any item on your Windows display, 
even colors outside the TitleMotion window.

3 Release the mouse button when the tip of the tool is on top of the color 
you want to match.

Notes
• If you have already applied gamma correction to the VGA display, the color you select and 

the color definition may not match exactly. Check your colors on a video preview to be 
certain.

Correct a Video Unsafe Color
Click on the warning icon to change the color encoding to the nearest safe 
color. If you prefer, you can use the normal color selection options to adjust 
the unsafe color.

Create a Color Gradient
This process works for backgrounds, text, or graphic objects.

1 On the Color & Texture tab, choose the Foreground, Shadow, or Edge 
for the gradient blend. This step is not necessary for backgrounds.

2 Click on the Color Blend Chip until you see the word TOP.

3 Set the color for the top of the gradient.

4 Click on the Color Blend Chip again until you see Bottom.

5 Set the color for the bottom of the gradient.

6 By default, the gradient occurs over the center of the object and the top and bottom part 
of the object are not blended. To change this, set the Gradient Top and Bottom values.

7 For a rotated blend, change the Gradient Angle. The dividing line on the Color Blend will 
rotate to match the angle you set.
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Create a Transparency Gradient
This process works for backgrounds, text, or graphic objects.

1 On the Color & Texture tab choose the Foreground, Shadow, or 
Edge for the gradient blend. This step is not necessary for 
backgrounds.

2 Set the Top and Bottom Transparency values. Make sure these 
values are different.

3 By default, the gradient occurs over the center of the object and the 
top and bottom part of the object are not blended. To change this, 
set the Gradient Top and Bottom values.

4 For a rotated blend, change the Gradient Angle.

Notes
• If you select the Match Values check box, TitleMotion will force the Top and Bottom 

Transparency values to match.

Adjust the Gradient Position
By default, the top and bottom of the text character, graphic object, or background is not 
blended and the blend occurs over the center of the screen. The Top and Bottom Gradient 
Position values determine how much of the object is blended.

Result Top Bottom

Blend across entire object 100% 0%

Blend in center half of object 75% 25%

No blended area Equal to Bottom Equal to Top
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Change the Gradient Angle
To rotate a color or transparency gradient blend, switch to the Color & Texture tab and change 
the Gradient Angle. If you want to rotate the blend more than 90 degrees, reverse the top and 
bottom color or transparency definitions. 

Gradient Options

Preview of Gradient Options

Gradient Options Applied
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How To... Create and Use Logos
The Logo Compose editor allows you to convert bitmap images to .lgo format for display. It is 
essentially an alpha paint package. Once you have your logos in .lgo format, you can insert 
them into CG layouts directly in a text line, or you can apply them to a special logo graphic 
object. You can access Logo Compose from the CG or the FX Editor. Just select Logo Compose 
from the Tools menu.

Paint with Alpha
1 To import an image into Logo Compose choose File➝Import/Export➝Import Image.

2 Select the Alpha Brush from the Logo Palette 
or from the Logo Compose menu.

3 Use the brush to paint all the areas of the 
image you want to be transparent.

Notes
• If you make a mistake, use the Restore Brush to 

reset the original alpha level of the image.

• You can use the Paint Can to flood fill a selected 
area.

• If you have a selected area, the paint tools only work inside the selected area.

• Zoom in up to 8x for precision work. Press SHIFT to zoom out with the Zoom tool.

Restore 
 Brush

Alpha 
Brush

Zoom
 Tool

Paint
 Can

Magic
Wand

Freehand 
Selection

Rectangle
Selection

Elliptical
Selection
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Change the Brush Shape
1 Import an image in to Logo Compose by selecting File➝Import/Export➝Import Image.

2 Select the Alpha Brush from the Logo Palette or the Logo Compose menu.

3 Use the brush options on the Options tab to change the shape, size, or edge of 
the brush.

Notes
• The smallest brush is a 2x2 rectangular brush.

• Zoom in up to 8x for precision work. Press SHIFT to zoom out with the Zoom tool.

Option Controls

Shape Double-click on the brush sample to cycle through the list of 
shapes: round, oval, and rectangular.

Size Click in the TOP HALF of the brush sample and drag the mouse 
up, down, left, and right to change the brush angle.

Rotation Click in the BOTTOM HALF of the brush sample and drag the 
mouse up, down, left, and right to change the brush angle. 

Edge Choose Hard or Soft. A Soft edge is anti-aliased. A Hard edge 
creates a sharp line of contrast.

Brush Sample
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Make Selections
1 Import an image into Logo Compose by selecting File➝Import/Export➝Import Image.

2 Choose one of the selection tools and use the mouse to select an area in the Logo Compose 
work area.

3 To add to a selection area, press SHIFT while you select additional areas.
4 To remove part of the selection, press SHIFT+CTRL while you select the area to be removed.

Notes
• When you have a selected area, the paint tools only work inside that selection.
• To remove all selections choose CTRL+D or Edit➝Select None.
• Zoom in up to 8x for precision work. Press SHIFT to zoom out with the Zoom tool.

Use Chrominance and Luminance Selection
1 Import an image into Logo Compose by selecting File➝Import/Export➝Import Image.

2 Choose the Magic Wand tool.

3 On the Options tab, choose Chrominance to 
select areas based on pixel color or Luminance 
to select areas based on a measure of lightness.

4 On the Options tab, choose Full to select 
matching pixels in the entire image or Region to 
only select matching pixels that border a pixel 
that has already been selected.

5 Click on a target pixel in the image to make the selection.

Option Controls

Rectangle Drag the mouse over an area to select it.

Ellipse Drag the mouse over an area to select it.

Freehand Draw the selection area using the mouse. Logo Compose 
automatically closes the selection area.

Magic Wand Click on a sample pixel and Logo Compose will use the Chrominance 
and Luminance settings to determine what should be selected.
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Notes
• If necessary modify the Tolerance level on the Options tab to select a range of colors or 

luminance levels that are close to the target pixel. Small tolerance levels mean that pixels 
have to be a very close match to the target pixel to be selected.

Crop a Logo
1 Import an image into Logo Compose by selecting File➝Import/Export➝Import Image.

2 Use a selection tool to select the parts of the image you want to keep.

3 Choose Logo Compose➝Crop to delete everything that is not selected.

Notes
If the selection area is not rectangular, Crop will fill the image with transparent pixels to make 
a rectangular shape.

Save a Color Logo
1 Use the Paint and Selection tools to create the logo you want.

2 Choose File➝Import/Export➝Export Image.

3 Choose a bitmap format type from 
the File Type List.

4 Select the number of bits-per-pixel 
you want to save. Normally this 
will be 32 or 16 for images with 
alpha.

5 Choose a file name for the image.

Notes
• If you plan to use this as a logo in a 

layout, save the image in 32-bit .lgo 
format.

• If you plan to use the image with another application, most programs can read 32-bit .tga 
images.

• If you save the logo in .bmp format, all alpha information is lost.
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Save a Monochrome Logo
Monochrome Logos can be formatted like text characters in the CG Editor. All color 
information is lost.

1 Use the Paint and Selection tools to create the logo you want.

2 Choose File➝Import/Export➝Export Image.

3 Choose .lgo from the File Type List.

4 Choose 1 bit from the BPP list.

5 Choose a file name for the image.

Insert a Text Logo in a Layout
1 To switch to the CG Editor click on the CG button on 

the Logo Compose toolbar. Select the Logos tab.

2 Double-click on an empty space in the Logo Map to call the Open Image dialog.

3 Select a bitmap image to display as a logo and click on OPEN.

4 Click on a logo on the Logo tab to insert it in at the cursor.

Notes
• Text logos take on the foreground, shadow, and edge formatting from current text style.

Insert a Graphic Logo in a Layout
1 Select the Logo button on the CG Palette. Click in the CG work area and 

drag a square while pressing the left mouse button. A bounding 
rectangle will appear with the word LOGO inside.

2 Switch to the Logos tab.

3 Double-click on an empty space in the Logo Map to call the Open Image dialog.

4 Select a bitmap image to display as a logo and click on OPEN. The Logo Map now contains 
your image.
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5 To replace the LOGO in the CG work area with your image click on the logo in the Logo 
Map.

6 Resize the graphic as needed in the CG work area.

Format a Monochrome Logo
1 Insert a monochrome logo in your CG layout using the above method.

2 On the Color & Texture tab, select the foreground, edge, and shadow colors and textures, 
just as you would for normal text and graphic objects.

3 On the Size & Attributes tab, set the size, shadow, and edge options, just as you would for 
normal text and graphic objects.

Format a Color Logo
1 Insert a color logo in your CG layout. Refer to “Insert a Graphic Logo in a Layout” on 

page 92 for details.

2 On the Color & Texture tab, select the edge and shadow colors and textures, just as you 
would for normal text and graphic objects.

3 On the Size & Attributes tab, set the size, shadow, and edge options, just as you would for 
normal text and graphic objects.

Notes
• If the logo is a .lgo format image, the shadow will follow the contours of the logo image. If 

the logo uses any other logo format, the shadow will follow the outline of the bounding 
rectangle of the logo.

• The edge on a graphic logo always follows the outline of the bounding rectangle of the logo.

LGO format Other formats
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How To... Apply Layout Templates
Templates are one of the major timesaving devices in TitleMotion. Once you have a standard 
layout worked out, save it as a template. The next time you need a standard title, load the 
template, make the text changes you need, and save the layout. 

Templates are also a good way to provide continuity across a project. If you define all the 
logos, colors, graphic styles, and text styles you need for a project in advance and save them as 
a template, you can ensure that all the layouts created with the template will use exactly the 
same colors and formats.

Templates include anything you put in a layout, from a simple lower third definition, to a 
complex layout full of logos and other graphic objects. When you save a template, make sure 
you use a good descriptive name so that you can easily recognize the template you are looking 
for in the list on the CG toolbar.

You will not really appreciate the power of templates until you start creating and saving your 
own templates. To add a template to the drop-down list on the CG toolbar select 
File➝Registry➝ CG Layouts, then click on the Add button on the Title Templates dialog.

Load a Layout Template
Selecting a new layout template replaces 
the current layout.

1 Select a template from the list on the 
CG toolbar.

or

2 Choose CG Layouts from the File➝Registry menu.

3 Select a template from the list.

4 Click on Load.
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Notes
• You can turn off the warning message when you select a new layout template by clearing 

the Warn Layout Changes option on the Character Generator tab in the Preferences dialog.

Create a New Template
1 Create the text, background, and graphic objects to save as a template.

2 Choose CG Layouts from the File➝Registry menu and click on Add.

3 Type in a meaningful description for the template so you can recognize the layout from its 
title.

4 Use the default template number or fill in a new identification number.

5 Click on OK to close the Add Layout dialog.

6 To load the layout template you just saved, click on Load.

Update a Template
1 Create the layout to save. This layout does not have to be based on the template you want 

to update.

2 Choose CG Layouts from the File➝Registry menu.

3 Select the template to modify and click on Update.

4 To load the layout template you just saved, click on Load. To close the dialog, click on 
Close.
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How To...Set Screen Markers
Screen markers are provided to make it easier for you to position text and graphic objects on 
the screen. Many users leave the Video Safe Title Area marker on all the time to make sure that 
objects are not accidentally cut off. All of the screen markers appear only on the Windows 
preview area. They are not rendered into the image and they are not sent to the frame buffer 
on a Take.

Display the Video Safe Title Area
1 Switch to the View tab.

2 Select the Video Safe Title Area check box.

The safe title marker is a guideline. It does not appear 
in rendered images. The safe title area marker also sets 
the boundaries for word wrap.

Edit the Safe Title Area
1 Switch to the View tab.

2 Click on the Edit button to the right of the Video Safe Title Area check box.

3 Click on a boundary (Left, Top, Right, or Bottom).

4 Use the slider to move the boundary to a new position. The number to the left of the slider 
measures the distance from the left side or top of the screen.

5 Click on Apply.

Display Tab Markers
1 Switch to the View tab.

2 Select the Tab Stops checkbox.

The tab markers are guidelines only. They do not appear in rendered images.
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Change Tab Position and Alignment
1 Switch to the View tab.

2 Click on the Edit button to the right of the Tab Stops check box.

3 Click on one of the five tab positions and choose an alignment option: Align Right, Center, 
or Align Left.

4 Use the slider to move the tab to a new position. The number to the left of the slider 
measures the distance from the left side of the screen.

5 Click on Apply.

The following graphic shows the markers and the CG Window.

Show Center Markers
1 Switch to the View tab.

2 Select the Screen Horz Center and Screen Vert Center 
checkboxes.

The horizontal and vertical markers are guidelines only. They 
do not appear in rendered images.

Show Text Baselines
1 Select a line of text.

2 Switch to the View tab.

3 Select the Text Baseline check box.
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The selected line of text will show a baseline marker running across the screen. You can use 
these markers to align lines with other text or with graphic objects.

Use Baselines to Align Text Lines
1 Switch to the View tab.

2 Select the Text Baselines check box.

3 Select the line to move into position.

4 Convert the line to non-tab constrained format by pressing CTRL+TAB.

5 Hold down CTRL, click on the line to move, and drag it into position. Match the baseline 
marker with the bottom of the target object.
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How To... Define Animation Layouts

Define the Layout as an Animation
1 In the CG Editor create your text and objects.

2 From the Layout Type drop-down list select Animation. This may already be selected by 
your NLE system.

3 Click on the FX Editor button on the CG toolbar.  This button is unavailable until you 

define the layout as an animation.

Edit the Text and Objects in an Animation
1 On the FX toolbar click on the CG Editor button  to switch back to the CG Editor.

2 Change the text, styles, or formatting as needed. You can add new objects or delete objects 
from the layout.

3 Return to the FX Editor.

Set Layer Options
1 Click on the Settings button on the CG toolbar.

2 In the Animation Settings dialog, choose a layer that you have text or 
objects on.

3 Select an option for the layer: As Single Object, As Lines, or As 
Characters.

4 Repeat steps 3 and 4 for each layer in your layout. If you do not select 
a layer, it will default to As Lines.

5 If you want to create a motion path for the background, select the 
Export Background checkbox.
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Notes
• It only make sense to move the background if you have created a color background or 

imported a background image.

• To change your layer options later switch back to the CG Editor and access the Animation 
Settings dialog.

• If you want to use the background for alignment only, export the background, create all the 
animation paths you want, and then turn off the include in render check box on the Time 
tab.

• Including the background in the significantly increases the size of the animation file that 
must be rendered. This requires a lot of system RAM.
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How To... Use Tools

Select a Tool
Tools include Position, Rotate, Offset, Extend, Skew, Twist, and Scale. You can select a tool in 
any of the following ways:

• Right-click anywhere on the FX Editor window (move the mouse pointer anywhere over 
the window, then press the right mouse button) and choose the tool from the menu.

• Click on the tool on the Animation palette. 

• Click on a tool located on one of the tabbed pages.

Apply a Tool
1 Select the tool you want to use. The cursor will 

change to display the active tool.

2 Click on the keyframe you want to change, and 
continue holding down the left mouse button.

3 Drag up, down, left, or right to make the change. 

Change Display Options
1 On the Animation palette, click on a display 

option to change what you see in the FX 
Editor window. The display options are the 
bottom row of buttons on the palette. You 
can select more than one display option.

• Display All Paths shows every path in the 
animation. 

• Display Text Outlines shows only the wireframe outline of the objects

• Snapshot of Selected Object provides a rendered bitmap of the current frame in time 
for the selected path only. The rest of the frames are shown in wireframe.

• Snapshot of All Objects provides a rendered bitmap of the current frame for all paths in 
your animation. 

Position

Rotate
Offset

Scale

Extend
Skew

Twist

Display All Paths

Display Text Outlines
Snapshot of All Objects

Snapshot of Selected Object
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How To... Work with Keyframes

Select a Keyframe
There are two ways to select a keyframe:

1 Click on the keyframe in the FX Editor window. Click on the center of the keyframe if you 
have overlapping keyframes.

2 On any tabbed page, locate the Key # list. Choose the number of the 
keyframe you want to select. Note that if you use this method, you 
choose the keyframe on the selected path. You may have to change 
the selected path first.

See Also
“Select a Path” on page 103

Add a Keyframe
There are three ways to add a keyframe:

1 Choose an option from the Edit➝Insert 
Keyframe submenu. You can insert a new 
keyframe before or after the selected 
keyframe, or at the current frame in time.

2 Click on a keyframe in the FX Editor 
window, then press ENTER. The keyframe will be added according to the default set on the 
Edit➝Insert Keyframe submenu.

3 Use a shortcut key. SHIFT+INSERT adds a new keyframe before the selected keyframe. 
CTRL+INSERT adds a keyframe after the selected keyframe. ALT+INSERT adds a keyframe at 
the current frame in time.

Delete a Keyframe
There are two ways to delete a keyframe:

1 Click on the keyframe in the FX Editor window, then press DELETE.

2 Choose Delete Keyframe from the Edit menu.
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Move Keyframes
There are three ways to move a keyframe:

1 Select the Position tool on the 
Placement tab or on the Animation 
palette, click on the keyframe and drag 
it to a new position.

2 Type position coordinates values into 
the Position fields on the Placement 
tab.

Select a Path
There are two ways to select a path:

1 In the FX Editor window, click on a keyframe in the path you want to select.

2 On the Placement tab, select the path name from the Object drop-down list.

Click on a keyframe in the 
 path you want to select.

Select the path name from
 the Object drop-down list.
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How To...Use Preview Options
TitleMotion offers three preview options for viewing your animation: Selected Objects Only, 
Show Trails, and Clip to Screen. Select the options from the Go➝Go Options submenu.

Preview the Animation
Animation previews only display in the FX Editor window. You cannot preview animations on 
your video monitor. You must return to your NLE and render the animation to see video 
playback.

1 Select Go from the Go! menu or click on the green Go button  located on the Preview 
toolbar.

2 To preview the animation in reverse click on the Play Reverse button located on the 
Preview toolbar. This option does not affect the order of keyframes on render; it 
reverses the order for the preview only.

3 To start the preview at the current frame, click on the From Current Frame button  
located on the Preview toolbar.

4 Modify the display with the options on the 
Go menu.

Option Preview

Selected Object Only Only displays the object you selected.

Show Trails Displays wireframe trails mapping your animation.

Clip to Screen Fits your animation to the screen parameters.

FX Editor Preview Toolbar
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Scroll Through the Timeline
1 Select the path you want to scroll through.

2 Click on the Frame Slider on the Preview toolbar and drag left or right to scroll through 
the timeline frame by frame. The current frame in time appears highlighted in green in 
the FX Editor window.

Frame Slider
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How To... Change Keyframe Attributes
Keyframe attributes allow you to change the shape and position of your text and objects. In 
the FX Editor on the Shape tab you will find the Extend, Skew, Twist, and Scale tools. On the 
Placement tab look for the Position, Orientation, Spin, and Offset tools.

Change Shape Attributes
1 Switch to the Shape tab to 

change the shape attributes.

2 Select the Extend, Skew, 
Twist, or Scale tool.

3 In the FX Editor window 
click on the keyframe you want to change.

4 Drag left or right to apply your selected tool to the X axis of the keyframe.

5 Drag up or down to apply your selected tool to the Y axis of the keyframe. 

Notes
• To scale a keyframe drag up or left to decrease the size of the object. Drag down or right to 

increase its size.

• Text and graphic objects are 2D objects, so there are no Z axis controls.

Change Placement Attributes
1 Switch to the 

Placement tab to 
access the positioning 
tools.

2 Select the Position, 
Orientation, Spins, or 
Offset tool.

3 In the FX Editor window click on the keyframe you want to change, then hold down the 
left mouse button and drag up and down to change the Y value or left and right to change 
the X value. Hold down both mouse buttons and drag the mouse up and down to change 
the Z value.

4 Release the mouse button when you are satisfied with the placement of the keyframe.
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Notes
• You cannot spin a keyframe by dragging the mouse. To spin an object select the keyframe 

and type in the number of spins in the X, Y, and Z fields.

• When you are changing the position of the keyframe with the mouse, press 1 to limit the 
motion to the X axis, press 2 to limit the motion to the Y axis, and press 3 to limit the 
motion to the Z axis.

Change the Object View
If you have applied a large twist or skew, it may be difficult to 
view the object to check the offset or other settings. Use the 
Object View window to check it.

1 Switch to the Shape tab.

2 Right-click on the Object View window.

3 From the right-click menu choose the option that does not have a checkmark beside it. 
The view in the window may provide a better angle of the object. If not, select the other 
option from the menu.

4 Use the scroll bar to zoom in or out of the object in the window.
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How To... Adjust the Spline
The spline is the path the object follows between keyframes. TitleMotion creates a smooth 
motion from one keyframe to the next, using the settings on the Spline tab. 

Select the Spline
1 Select the spline you want to change.

2 Switch to the Spline tab.

3 Choose a spline from the radio buttons on the left: Position, 
Rotation, or Shape.

Notes
• You can see changes in the Position spline in the Preview 

window. You can only see changes in the Rotation and Shape spline when you play the 
animation preview.

• You can only see changes in the Rotation Spline when you have added a spin to the path or 
changed the orientation.

• You can only see changes in the Shape Spline when you have added a Twist or Skew.

Tension Slider

Continuity Slider

Bias Slider

Ease In Slider Ease Out Slider

Reset Button

Number Fields
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Adjusting the Spline Properties
• The Tension property controls the slack or tightness of the spline path.

• The Continuity property controls the smoothness of the spline path as it moves from one 
keyframe to another. This is especially evident at corners.

• The Bias property determines whether the motion is weighted to the segment coming into 
or the segment coming out of the keyframe.

Changing the Tension, Continuity, or Bias
1 In the FX Editor window click on the keyframe you want to work with.

2 Switch to the Spline tab.

3 Choose a spline from the radio buttons on the left: Position, Rotation, or Shape.

4 Click on the appropriate slider button. For example, if you are changing the tension of the 
spline click on the Tension Slider button.

5 Drag left to increase or right to decrease the tension and discontinuity features.

6 If you are changing the bias feature drag left to weight the motion coming into the 
keyframe, or drag right to weight the motion going out of the keyframe.

Tension = 0Tension = -5 Tension = -1 Tension = +1 Tension = +5

Continuity = 0Continuity = -5 Continuity = -1 Continuity = +1 Continuity = +5

Bias = 0Bias = -5 Bias = -1 Bias = +1 Bias = +5
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Reset a Value
There are three ways to reset a value on the Spline tab. 

• Click on the reset button located beside the control. 

• Double-click in the number field to reset the value 
back to the default. 

• If you are In the middle of making a change and you 
realize you are changing the wrong thing, press ESC 
to set cancel the change. 

Ease Into a Keyframe
The Ease In control allows you to adjust the speed of the effect coming into the selected 
keyframe.

1 Position all keyframes in your path.

2 Switch to the Spline tab.

3 Select the keyframe you want to ease into.

4 Click on the Ease In slider and drag it to the right to increase the speed into the keyframe, 
or drag it to the left to decrease the speed into the keyframe.

Ease Out of a Keyframe
The Ease Out control allows you to adjust the speed of the effect coming into the selected 
keyframe.

1 Position all keyframes in your path.

2 Switch to the Spline tab.

3 Select the keyframe you want to ease out of.

4 Click on the Ease Out slider and drag it to the right to increase the speed out of the 
keyframe, or drag it to the left to decrease the speed out of the keyframe.

Reset Button

Number Fields
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How To...Use Filters
Filters change the appearance of a keyframe as it moves through time, or from one keyframe 
to the next. 

Applying a Filter
1 Select the keyframe that contains the object you are applying the filter to.

2 Switch to the Filters tab.

3 Apply your filter by entering a value in each field located below the filter name. 

Notes
• Because the filters are rendering filters, you cannot see the effect of changes until you 

return to to NLE system and render the animation.

Filter Result

Transparency The transparency of the object gradually changes to reach 
the transparency value you set for the target keyframe.

Crop Parts of the objects will gradually cut away to reach the 
crop value you set for the target keyframe.

Mosaic  The clarity of the object gradually diminishes to reach the 
pixelation value you set for the target keyframe.

Luminance The brightness and contrast will change to reach the 
Luminance values you set for the target keyframe.

Tint The color of the object will gradually change to reach the 
Tint values you set for the target keyframe.
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Apply a Filter Value to Several Keyframes
1 Set the filter values you want to use. 

2 Right-click on the icon for the filter you want to 
apply. 

3 Select an Apply option.

• Choose Apply to all Keyframes to apply the same 
filter values for all the keyframes in the path.

• Choose Apply to all Forward to apply the same filter values to all the keyframes to the 
end of the path. This option is not available if the selected keyframe is the last keyframe 
in the path.

• Choose Apply to all Previous to apply the same filter values to all the keyframes up to 
the current one. This option is not available if the selected keyframe is the first 
keyframe in the path.

Note
• Select Reset to clear all the Filter values for the selected keyframe. As a short cut, just 

double-click on the icon for the filter to reset all the filter values for the selected keyframe.
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How To... Use Motion Templates

Apply a Motion Template
1 Select the keyframe where you want to apply the template.

2 Switch to the Templates tab.

3 Choose a template from the list.

4 Select options to apply to your template. (See “Choose Template Options” on page 114)

5 Click on Apply. This button is located on the bottom right corner of the dialog.

Notes
• The Preview window to the immediate right of the Template list displays how the template 

will look applied to the selected keyframe or path. This preview is a still only, for an actual 
motion preview, apply then template and then choose Go! from the Go menu.

• With the Apply and Insert options, you determine where the template is applied and how it 
is added to the current path.

See Also
“Change a Layout Created from a Template” on page 115

Preset Templates List Apply Options Timing Options

Preview Window Insert Options Apply Button
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Change the Direction of a Template
You may need to change the template direction to create the effects you want. For example, if 
you have a template that grows from infinity to full screen, you can reverse the effect to make 
the object disappear to infinity.

1 Select the keyframe at which you want to apply the template.

2 On the Templates tab, choose a template from the list.

3 From the Insert options, select the Reverse checkbox. 

4 Click on Apply.

Choose Template Options
1 On the Templates tab select a template from the list.

2 Select the Overwrite option if you want to wipe out all the 
information currently in the FX Editor window, and replace 
it with the information in the template.

3 Choose an Apply option: Relative or Absolute. 

• Choose Absolute to use the position information stored 
in the template.

• Choose Relative to use the current object position.

4 Select the Reverse option to reverse the order in which the keyframes will appear.

5 Select an Insert option: Before or After Template.

6 Set the Start Frame for the template by entering a number in the Start Frame field. This 
number is relative to the starting point of the effect in your timeline.

7 Set the Length of the template by entering the exact number of frames you want the path 
to run in the Length Field.

8 If you are applying the template to more than one path, type a value into the Stagger field 
to stagger the paths. 

9 Click on Apply.
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Stagger a Template
Staggering a template can be very useful to have more than one object follow the same path, 
one after another. For example, if you want to have the letters in a word follow the same path, 
select the path and set the Stagger value to 5 or 10 frames. Each letter will follow the same 
path, one after another, when you play the animation.

1 On the Templates tab choose a template from the list. 

2 Select the All Objects checkbox or type in the number of objects in the Count field. These 
options are located to the left of the template list.

3 Set a value to Stagger in the Stagger field. When you apply the template, each path will 
start after the number of frames you set in the Stagger field.

Change a Layout Created from a Template
1 Apply the template to the paths or keyframes.

2 Make any changes to the placement or properties of any or all keyframes. You can change 
any information set by the template including timing, shape, placement, and spline.

Add a Template to the List
1 Position and change the properties of the keyframes for all paths in the FX Editor window. 

When all paths are set, and you are happy with all keyframes, go on to step 2.

2 Switch to the Templates tab.

3 If your animation has more than one path, you must choose 
whether to add only the selected path, or all paths. The default 
option adds only the selected path.

4 Click on the Add Template button. 

5 Enter a name and number for the template. 

6 Click on OK to add the template to the list.

Tip
To create an effect where each character in a word follows the same path, define the path for 
one character, add the effect to the template list, making sure you only add the selected path, 
reset the animation, and apply the template to all objects with a stagger of a few keyframes.
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Delete a Template
1 On the Templates tab select the template you want to delete from the list of templates. Only 

click on the template once. If you click on it twice, you will apply it to the current 
animation.

2 Click on the Delete Template button. 

3 Click on Yes to confirm that you want to delete the template, or click on No to exit the 
dialog without deleting the template.

Rename a Template
1 On the Templates tab select the template you want to rename from the list of templates.

2 Click on the Rename template button. 

3 Enter a new name for the template in the space provided. 

4 Click on OK to make the change and to close the dialog.

Update a Template
1 Apply the template to the paths or keyframes currently in the FX Editor window.

2 Make changes to the placement or properties of as many keyframes as you like.

3 Click on the Update Template button. 

4 Click on Yes to overwrite the initial template with the changes you made. Click on No to 
exit the dialog without making the change to the template.
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How To...Set Timing Options

Define the Start Frame
1 Switch to the Time tab.

2 In the Start Frame field, type in a frame number. The 
object will not begin to fly until the frame number 
you entered, but the total time consumed by the 
animation remains the same.

Notes
• To define the end frame type in a frame number in the 

End field.

• All frame numbers are relative to the beginning of the 
source clip, not absolute frame numbers from the NLE timeline.

Reverse the Order of Keyframes
1 Select the path you want to reverse.

2 Click on the Reverse Path button on the Animation palette. All keyframe labels in the 

path will change to reflect their new position. Note that this affects every keyframe in the 
path; you cannot reverse only part of a path.

Notes
• To reverse all the paths in the Animation, click on the Reverse All Paths on the Animation 

palette. . 

Start Field
End Field
Duration
Total Frames
Final Frame

Horizontal Time Slider

Vertical Time Slider

Frame Field
Pause Field

Render Path

Allow Modifications

Remain on Screen

Start Field

End Field
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Lock a Path
1 Switch to the Time tab.

2 Click on the Remain on Screen icon beside the path you want to lock. 
While the path is locked you cannot edit or move keyframes.

View the Entire Timeline
1 Switch to the Time tab.

2 You may need to use the Zoom In or Zoom out controls to the left of the time slider to see 
the entire path.

3 Click on the Horizontal Time slider and drag it to the right to scroll through the time line.

View All Objects
1 Switch to the Time tab.

2 Click on the Vertical Time slider and drag it down to scroll through the entire timeline. 
Each object appears on its own time line.

Change the Amount of Time Between Keyframes
1 Select the keyframe where you want to change the time. The time between the previous 

keyframe and the keyframe you select will be affected.

2 Switch to the Time tab.

3 In the Frame field, reduce the number of frames by entering a new 
number or by using the down arrow. Watch the display in the FX Editor 
window to see how the keyframes are affected.

Notes 
• The total number of frames in the path is not affected; the reduced frames are redistributed 

along the remainder of the path.

• If your NLE system supplies a source clip, it will be marked on the timeline. If you make the 
path longer than the timeline, the path with the problem will turn pink until you correct the 
length. If you do not correct it, the path will be truncated when you return to your NLE 
system
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Add a Delay at a Keyframe
1 Switch to the Time tab. 

2 Select the keyframe at which you want the animation to stop and wait 
before continuing on to the next keyframe. 

3 In the Pause field, type in the amount of time in frames that you want 
the animation to stop and wait.

Notes 
• Adding a delay at a keyframe affects the entire timeline for the path.

Adjust the Length of a Path
There are two ways to adjust the length of a path: by adding a delay at a keyframe, or by 
increasing or decreasing the overall time (in frames) that the path will run. This procedure 
increases the overall time a path will take. 

1 Switch to the Time tab.

2 Decide which path you want to increase or decrease in length.

3 To increase the number of frames in the path, click on the right edge of the time slider for 
the path you want to change and drag it to the right. The number in the Total Frames field 
will increase as you drag. Release the left mouse button when you reach a sufficient 
number of frames. To decrease the number of frames in the path, click on the left edge of 
the time slider and drag it to the left.

or

4 Enter a number directly in the Total frames field for the selected path.

5 If your NLE system supplies a source clip, it will be marked on the timeline. If you make 
the path longer than the timeline, the path with the problem will turn pink until you 
correct the length. If you do not correct it, the path will be truncated when you return to 
your NLE system

Shift a Path in Time
1 Switch to the Time tab.

2 Decide which path you want to shift in time.

3 Click on the middle of the time slider for the path you want to shift and drag it to the right 
to shift it forward in time, or drag it to the left to shift it backward in time.
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or

4 Enter a new start frame in the Start Frame field.

Set the End Frame
1 Switch to the Time tab.

2 In the Object drop-down list select the path you want to change.

3 Enter a new End frame number in the End Frame field.

Set the Start Frame
1 Switch to the Time tab.

2 In the Object drop-down list select the path you want to change.

3 Enter a new Start frame number in the Start Frame field.
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How To... Render

Render the Animation
1 Rendering does not occur until you return to your NLE system. You cannot render within 

TitleMotion. Choose File➝Save or File➝Exit then select the render timeline option in 
your NLE system. 

2 You can set options within TitleMotion that will affect the render such as Omitting a Path 
from the Render, and Forcing a Path to Remain on Screen.

Include/Omit a Path from the Render
1 Switch to the Time tab.

2 Locate the Render Path buttons located to the left of the time slots. 
Each time slot has its own Render Path button.

3 To include a path in the render, the button beside the path must have an X inside it. If the 
button is blank, the path will be omitted from the render.

4 To include all paths in the render, select the Render Path checkbox for each path.

Force a Path to Remain on Screen
Use this procedure to force a path to remain on screen even when its timeline ends before 
other paths.

1 Switch to the Time tab.

2 Locate the Remain on Screen button located to the left of the time slots. 
Each time slot has its own push pin button.

3 To force a path to remain on screen, the push pin must be pointing down, as though it is 
"pinning" the path in place. If the push pin is sideways, or unpinned, the object will 
disappear from view when it reaches the end of its path.

4 To force all objects to remain on screen, select the Pin Time Lines push pin for each path.
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Adjust to Changes in the NLE Timeline
In many NLE systems, you can adjust the length of an animation effect on the timeline. Use 
the Edit Clip Options dialog on the Time tab to determine what will happen when the 
animation effect length is modified.

1 Choose Scale to Fit the Clip if you want to automatically adjust 
the animation to changes in the effect length.

2 Choose Crop on the Right to truncate the animation if you make 
the clip shorter or leave it untouched if the effect is made longer. 

3 Choose Auto Select to modify the effect based on its position in 
the clip.

 

Animation Structure Result of Scaling

If the animation is placed in the 
middle of the source clip, not 
touching either end ...

the animation is scaled when the 
effect length is edited in your NLE, 
so that changes to the effect length 
are distributed proportionally 
across the animation.

If the animation touches only one 
end of the source clip ...

the animation is not scaled when 
the effect length is edited in your 
NLE. This preserves “fly in” or “fly 
off ” moves.

If the animation fills the source clip.. the animation is scaled when the 
effect length is modified in your 
NLE, so that changes to the clip 
length are distributed 
proportionally across the DVE.

Edit Clip Options Button



TitleMotion 123 

Technical Support
Identifying who to call for technical support may be difficult: 

• If you are having problems with your NLE software, contact the manufacturer. 

• If you are having problems with the hardware output device, contact the manufacturer. 

• If you are having problems running or using VideoFX, contact Inscriber Technology 
Corporation.

Inscriber Technical Support
Email: support@inscriber.com 

Web: www.inscriber.com 

Fax: 519-570-9140
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